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We hope you like our steam punk cover shot – it’s our take
on a fictional past created using very real, high-end digital
technology. In fact, what started out as a simple cover shoot
turned into a full-blown multimedia project with a life of its
own, and the article on page 86 tells you all about how it
took shape. 

Back in the present, our piece on home-build studio gear
gives you practical tips on how to make your own bespoke
equipment – and the results are just as good as expensive
pro gear at a fraction of the cost. 

Have you ever found yourself frustrated by the lack of
depth of field in your macro shots? Lens experts tell us 
that there is no way around the laws of optics, but focus
stacking gives you an alternative option and enables you 
to photograph even the smallest insect in perfect focus
from wingtip to wingtip. Check out the article on page 76
for details on how.

And for those of you who long for a little discreet light and
shade amongst today’s intense, all-pervasive colors, our
black and white workshop is right up your street. We show
you how to find and shoot great monochrome subjects and
how to use digital camera and processing technology to get
the most out of your digital darkroom.

Have fun exploring our corner of the wonderful world of
digital imaging!

Juergen Rink
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André Wagner’s fresh take on landscape photography 
has brought him worldwide recognition. He finds most of 
his subjects at night and photographs them using very 
long exposures.
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Informative and 
beautifully made

Thank you for your speedy mailing of issue 4
of your excellent magazine. I discovered it
through Ken Rockwell’s site. I received today
issue 1 of your publication; it is also very
informative and beautifully made (pity 
the manual lens article was only Canon
centered – I’m a Nikon user).

At last, I can’t resist asking you for a re-
edition of issue 2, it must be a killer – I would
love to get one.

José R. Carneiro

Sorry, but issue #2 is completely sold out.

… and what people are saying
about us on the Web:

A photo magazine worth
reading

Let me be blunt: Most photography
magazines on the newstands these days suck.
Fortunately there are exceptions, one of the
most noteworthy of which is c’t Digital
Photography. The “c’t“ is an abbreviation of
“computertechnik” and is pronounced “C.T.“
c’t is the largest selling tech magazine in
Europe and is based in Hannover, Germany.
c’t Digital Photography magazine is an English
translation of computertechnik’s quarterly
digital photography specials.

Here, in no particular order, is what I like
about this magazine:
– Top-quality photos and reproductions
– Plentiful illustrations, many of which cover

a full page or two-page spread
– Well-conducted and documented tests of

photo equipment and software
– In-depth tutorials on useful techniques and

software
– A free DVD that provides additional tutorials

and applications
In short, these are photo magazines you

could actually learn something from and be
inspired by – assuming you’re into that sort of
thing. I wouldn’t wait too long though – Issue
2 has already sold out of its print run.  

http://shutterfinger.typepad.com/shutterfing
er/2011/09/a-photo-magazine-worth-
reading.html

Shutterfinger

Congratulations and 
thank you

For a great many years now I have been
purchasing photographic magzines and
books… And then came c’t Digital
Photography. 

To say I was imapacted by this magazine,
is a tremendous understatement. $14.95 is a
lot to pay for a magazine normally, but this
one was such a breath of fresh air, that I
didn’t take long to convince myself it was
worth it (keep in mind I am Scottish, and
spending money is anathema to me).

Not only did I decide to purchase the mag
at the store, I logged on to my laptop and
ordered all the back issues available, which
excluded issue 2 as they were out of stock on
that. 

So what makes this magazine worth all
that effort? One, the magazine is physically
bigger. The articles are in-depth, technically
complete and entertaining. The use of charts,
tables and photographs help to illustrate the
information being offered. Perhaps the
reason the articles and tests are so in-depth
and detailed is, this magazine is a quarterly
issue. Perhaps because they are not rushing
to meet weekly or monthly deadlines, the
editorial staff and contributors can take some
pride in producing a magazine unlike any
other availabile in quality and content, in
today’s over populated photographic media
circus.

I say Congratulations and THANK YOU c’t
for fulfilling my expectations every issue.

www.clivewatsonphotography.com/?p=69

Clive Watson’s Photography Blog 

A great magazine 
for photographers

What I really liked is that every article is deep
and detailed. You know how technically
oriented I am, and I was pleased to find that
magazine editors think the same.

There is plenty of room for long reviews,
gear tests and other interesting stuff. HDR,
lens reviews (with image examples and 100%
crops), HDSLR, etc. What I also like is that
they are oriented toward enthusiast and
professional photographers, not just a
beginners. Truly, I’ve enjoyed it. As a bonus,
every issue comes with a DVD full of images
from the tests, software, plugins for
Photoshop and other useful stuff. 

www.akelstudio.com/blog/the-great-
magazine-for-a-photographer-meet-ct-digital-
photography/

AKELstudio, Alex Koloskov
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Reader Forum

Readers’ Letters

We are always happy to receive your
comments and suggestions in a letter,
an e-mail to editor@ct-digiphoto.com
or at www.facebook.com/ct-digiphoto.
We reserve the right to abbreviate your
input for publication. Our comments
are printed in italics.

Tell us what
you think:
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“I took this photo
using my charismatic
Cambo Ultima view
camera, and I hope
you’ve noticed
unusual focus in the
image: the spread of
magazines all in
focus, while any
other non-flat objects
are blurred. This is
what happens when
you tilt the lens.“ 

Alex Koloskov





Sometimes pictures tell great stories and
sometimes there are stories to tell about

great pictures. 
In video #1 Graham Howe introduces the

fascinating story of E.O. Hoppé, an often
neglected photographer who nevertheless
achieved worldwide fame at the height of his
success in the 1920s. Was he actually the best
photographer of the early 20th century? And
what happened to his fantastic work? This 
video provides the answers to these and 
other fascinating questions. 

Our second video describes how a crazy,
beer-fuelled idea led to the creation of the
largest camera in the world and the
correspondingly huge images it captures. Just 
to give you an idea how crazy the plan was – the
camera itself used to be an airplane hangar!

Video #3 gives you a look behind the scenes at
the work of Jean-Baptiste Huynh – a photographer
who says that digital technology doesn’t
interest him, but who nevertheless creates
highly contemporary monochrome images. 

All video material is provided courtesy 
of FotoTV.com and is part of the site’s
comprehensive subscriber video library. (jub)

As introduced in our article on Macro 
Focus Stacking, Helicon Focus merges

multiple images shot with varying planes 
of focus to produce a single image with
increased depth of field. The software is 
multi-processor-compatible, automatically
adjusts and resizes source images and 
ensures high-quality results through its 
use of advanced interpolation techniques. 
It supports a wide range of graphic file 
formats as well as direct RAW input. The 
Pro and X64 windows versions of the program
also include the Helicon Remote tool, which
automates focus and exposure bracketing 
using a direct tether for all live view DSLRs 
from Canon and Nikon.

This issue’s DVD includes a trial version 
of the program that you can convert into
a fully licensed version (valid until July 
1st 2012) by following the link in the Focus
Stacking Sample Images section of the DVD. 
c’t Digital Photography readers are also entitled
to an exclusive US$40 discount on an upgrade
to a one-year license or a 20 percent discount
on an unlimited Pro license (offer valid until
December 31st 2012). (jub)

Whether they are painstakingly 
composed or just simple snapshots,

some photos simply aren’t sufficiently 
sharp. This is usually either because the 
subject moved unexpectedly or because the
focus setting used was incorrect. As a result,
we decided to include a full version of the
small but perfectly formed DeblurMyImage
1.6 on this issue’s free DVD. This tool has just
two functions that are both based on the same
four algorithms. These are designed to deblur
without amplifying image noise, deblur quickly
without using much memory, deblur
aggressively and to perform stable, moderate
deblurring. 

The level of detail, the deblurring method
and the strength of the effect can be individually
set for both the “out of focus correction” and
“motion correction” tools, and both functions
include live preview functionality to help you
test the effect of different settings.

The software provided on our DVD is a 
full standalone version that normally retails 
for e14.99 (about US$20). A Photoshop
plug-in version of the program is available from
www.adptools.com for the same price. (jub)

Black-and-white
Photography Videos

Videos: This set of three videos
comple ments this issue’s black-and-
white workshop in a number of
fascinating ways.

  Helicon Focus

Full version: This powerful program
creates one completely focused image
from several partially focused images
by combining the correctly focused
areas from each.

DeblurMyImage

Full version: A great little tool for
adding that extra dose of sharpness
to nearly perfect photos.

8 c’t Digital Photography 6 (2012)

DVD Highlights
Highlights of this issue’s free DVD include a complete eBook, sample images
from the articles and tests in the magazine and a special offer discount for a full
license of the Helicon Focus software introduced in our focus stacking article.
Our additional free software includes a series of FotoTV.com videos on black
and white photography from the early 20th century right up to today.    

DVD | Highlights
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DVD | Contents

The rapid development that digital
photography has seen in recent years has

spawned many books that describe image
processing and digital workflow techniques in
detail. Often, the real aim of photography – i.e.,
to create images that tell stories – gets lost
along the way. 

In this beautifully illustrated book, Hoffmann
gives us an alternative view of the subject of
black-and-white photography, dedicating a large
part of these 272 pages to describing how to find
fascinating photographic subjects and how to
compose successful monochrome images
around them. He covers various sub-themes,
including street and abstract photography,
portraiture and architecture, as well as giving us
insights into the basic rules of composition, such
as the golden ratio and the use of shape. 

Additional chapters on choosing the right
gear and advanced, Photoshop-based digital
darkroom technique round out this excellent
and thought-provoking work.

The complete current version of the book is
included here on DVD. The new, revised print
edition is scheduled for release through
www.rockynook.com in January 2012. (jub)

The Art of Black and
White Photography

eBook: In contrast to many similar
publications, this book by Torsten
Andreas Hoffmann emphasizes the whys
and wherefores of image composition
rather than concentrating on digital
image adjustment and enhancement.

Photo Tools
AmoK Exif Sorter 2.56

AutoStitch 2.2

CombineZP 1.0

digiKam 2.2.0

Enblend/Enfuse 4.0

EnfuseGUI 2.1

ExifTool 8.66

HD View SL 1.2

Hugin
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MacPorts

Panorama Perfect Lite 1.6.2

PhotoRec 6.12

Picolay 2011-10-06

RawTherapee

Sofortbild 1.2.2

Xee 2.2

Full Version Software
DeblurMyImage 1.6

Helicon Focus Pro 5.2.9 
(special edition)

eBook
The Art of Black and White Photography

Image Processing Tools
FDRTools Basic 2.4.0

GIMP

GIMP Portable 2.6.11

GREYC’s Magic 
Image Converter (G’MIC)

Inkscape

Inkscape Portable 0.48.2

PSPI 1.0.7

ShiftN 3.6

SmartCurve 2.2

StylePix 1.8.6.0

StylePix Portable 1.8.6.0

Videos
The Work of E. O. Hoppé

Portrait: Jean-Baptiste Huynh
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Sample Images
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Focus Stacking Sample Images



Portfolio | André Wagner

André Wagner finds most of his subjects
outdoors at night and photographs

them using very long exposures. He is a
master at taking his time, waiting until the
light, the subject and the overall feel of a
situation are just right. The results are
fascinating photos of windblown trees in
New Zealand or mysteriously glowing woods
on the Mediterranean island of Majorca.

He consciously resists the urge to take
photos all the time, wherever he is, and prefers
to concentrate his thoughts on philosophy or
mythology and engage with ideas about the
elements and terms like fire, wind and
creation. The next photographic project
emerges when the time is right, be it in India,
New Zealand or somewhere closer to home.

These images are a long time in the
making, and the processes involved elicit
more than just a nod of recognition from
viewers. They run counter to the way we are
used to seeing things and, if it were not for

their enigmatic twilight feel, the nighttime
long exposures could almost be taken for
daylight shots. Another factor that makes it
impossible to overlook these photos is their
format: ranging from one to three meters
square, these huge LightJet and Dodeka
prints really stand out, even in the largest
museums or galleries.

Acclaimed by critics and well received by
galleries and collectors, Wagner’s art scratches
a very contemporary itch. The man himself is
unwaveringly professional, releasing his large-
format works in limited editions of between
three and seven prints and often mounting
exhibitions that show just a single series or
one particular project. The exact subject
matter is decided in close consultation with
galleries, and always with potential collectors
in mind: What’s popular at the moment? What
will demand be like in 10, or even 20 years?
Many projects are simply shelved until the
time is right.

Photographers typically clam up when
asked about their photographic tricks and
techniques. Wagner made an exception for c’t
Digital Photography and gave us a glimpse
behind the scenes with the details revealed in
his commentary on the images shown on the
following pages.

He uses both digital and film 
cameras – digital for commissioned work and
daylight photography and medium-format
cameras such as the Mamiya 7 II or 645 Pro for
nighttime photography and most of his large-
format pieces.

Analog technology is far superior to digital
when it comes to making exposures that can
last several hours – and these are not the only
extreme lighting situations in which Wagner
prefers celluloid to chip. The choice between
analog and digital is not a matter of faith, but
simply a matter of selecting the method that
best allows him to visualize what he has in
mind. (jr)
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Portfolio

André Wagner
André Wagner’s fresh take on landscape photography has brought him a long way.
From his modest beginnings in the graffiti scene, he is now  based in Berlin and has a
reputation that nets him invitations from galleries around the world. We spoke to this
single-minded 30-year-old professional about his art, his craft and his business.



Opening (Berlin, Tempelhof Airport, 2011,
from 9.55 to 10.10 a.m., 240 x 140 cm)

“This photo was taken at the opening of the
Bread & Butter clothing trade fair at Tempelhof

Airport in Berlin. I exposed the shot from five
minutes before until 10 minutes after the gates

opened to capture the crowds flooding in.”
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Portfolio | André Wagner

Govardhan (India, 2008, 
100 x 150 cm)

“During my travels in India I saw
a pilgrim embracing a holy tree
on Govardhan Hill. Holy places

interest me greatly because they
make a special atmosphere
visible, like in this photo.”



13c’t Digital Photography 6 (2012)



14 c’t Digital Photography 6 (2012)

Portfolio | André Wagner

On the Left Side 
(Majorca, 2009, from 10.39 to
10.44 p.m., 140 x 180 cm)

“I find natural scenery in
artificial light fascinating. This
scene was illuminated by light
coming from a tennis court.”

Dimension Door (India, 2004, from 4.15 to 4.21 a.m., 135 x 200 cm)

“I wanted to portray fire spreading outwards, like the ripples produced by a stone when it is
dropped into water. This location is a dangerous place for tourists after dark, which added to the
challenge. We travelled 40 kilometers by motor rickshaw from Vrindavan to Kusum Sarovar. I had
been suffering from stomach pains for the previous four weeks and the potholes made the trip
almost unbearable. Two friends helped me, with one acting as a security guard and the other,
photographer Jens Hocher, helping me to set up the fire effect. Suddenly I realized that there were
about 30 locals sitting behind me, watching me very intently – all at four o’clock in the morning.”
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Portfolio | André Wagner

Slope Point (The southernmost point of New Zealand’s South Island, 2006, 108 x 162 cm)

“I discovered these trees on a photo tour through New Zealand. I bought a 20-year-old van
for NZ$1,000 and traveled 14,000 km in four months. The out-of-the-way places were the

most interesting. In my mind, I’d been searching for these trees for years.”

Golden Bridge 
(Lithuania, 2007, 

from 10.16 to 10.53 p.m.,
110 x 150 cm)

“In 2007 I accepted an
invitation to go to Kaunas,

Lithuania, to receive a prize
at the Kaunas Photo 07

show. I was very inspired by
this bridge and used it to

make this image for my
‘Romance of Elements’

series. I wanted to present
fire so that it looked like

water, and it took six people
to help me turn my idea of

fiery rain into reality.”
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Portfolio | André Wagner
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Portfolio | André Wagner

Express (Berlin, Germany, 2003, from 0.18 to 1.02 a.m., 80 x 120 cm)

“My ‘Romance of Elements’ series is all about the elements – earth, air,
fire and water. We worked with sparklers behind the train and then
threw them between the freight cars. Because I wanted to produce just
one single image, I had to coordinate the ambient light with the bright
sparkler trajectories by using different aperture settings. The fragmented
star trajectories are a result of the breaks in the exposure.”
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Reinhard Merz, Erich Baier

Digital

Black-and-white
Photography

Plus:
Complete eBook

The Art of 
Black and White

Photography

on DVD



In the analog world, black and white was considered
to be a kind of declaration of indpendence, allowing
photographers to fine-tune an image as much or as
little as they wanted in a home darkroom. Digital
technology has given us practically limitless
processing and color correction options, but today,
there is a perceptible trend toward “back to the
basics” photography. This article explains how to
create fascinating monochrome images from your
color photos and how to hone your instinct for 
finding suitable black-and-white subjects.



For more than 150 years, black-and-white
photography meant spending hours in

a darkroom, with the enlarger as the center
of the vital second stage in the creative
process. And remember – back then, you
had to choose whether you wanted to shoot
in black and white or color before starting a
shoot, and you had to know how to use
specific film types and filters to produce the
best possible exposure. Not only that, but
you also had to tolerate the acid smells of
developer and fixer to produce your
finished image. Nowadays, computers have
taken over the lab work and make black-
and-white photography a whole lot easier.
The digital workflow provides us with
consistently excellent raw material that we
can tweak and fine-tune to our hearts’
content. 

But why shoot in black and white at all? Is
it simply because many of us grew up with
black-and-white images and subconsciously
stick to tradition? More importantly, a great
photo is always a subjective interpretation of
a scene that “freezes” a moving, three-
dimensional moment into two stationary
dimensions. The lack of color produces a
strong feeling of abstraction that doesn’t
necessarily make an image better or worse,
but certainly makes it different – perhaps in
the same way that a piece of music sounds
different performed by a big band than it does
as a piano solo.

If we analyze the differences between
great color and black-and-white images, we
quickly recognize that black-and-white
photos live from the interplay between light
and shade or patterns and symmetry. If these
are the major characteristics of an image, it
will often look better in monochrome than in
color. Other subjects, such as a sunset or a
forest in fall, are characterized by the interplay
of color and are not nearly as effective if
captured in black and white

Seeing in Black and White

Today, shooting FOR black and white no
longer means shooting IN black and white.
Even if your camera has one, don’t use 
black-and-white mode – you are shooting not
just for the moment, but rather to process
your images later, and color images contain  a
great deal more image data than
monochrome images produced in-camera.
Black-and-white images owe their
effectiveness to details to a much greater
extent than color images do, so always shoot
in RAW format if you can. In contrast to JPEG
image files, which can only be saved with 8-
bit color depth, RAW images can be saved
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Black-and-white Photography | Learning to See
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Color or black and white? Which is more effective depends on the subject.



with 12, 14 or even 14 data bits per color
channel and allow you to produce a much
broader tonal range. 

In spite of today’s virtually limitless
processing options, the depth of field, amount
of blur and point of view captured in an image
are still determined at the moment you
release the shutter. If you are in any doubt,
always shoot multiple versions of an image to
give yourself the greatest possible range of
processing options later. The original photo
delivers the raw material, and any mistakes
you make at the shooting stage can only be
rectified with a disproportionate amount of
effort, if at all. 

Graphic Elements: 
Light and Texture

A common feature of all great black-and-
white photos is their use of contrast as a
means of expression. Skilled use of contrast –
whether technically or artistically – often
makes the difference between an acceptable
photo and a great one. This is why shots that
contain a high degree of optical and
graphical contrast often look better when
converted to black-and-white. Light and
shade, shapes and lines, or rounded and
square are all contrasts that attract a viewer’s
attention. It is also important to consider the
composition of the individual elements while
shooting, as their relative positions cannot
be altered later, even if you reframe the
entire image.

It is more important to make sure that
your image doesn’t contain any
unnecessary elements than it is to use every
last square millimeter of space within the
frame. You will most likely perform your
final framing on a computer anyway, and
you are sure to make your final choice of
tonal values during processing. The most
important thing to remember while
shooting is to give yourself enough room
for maneuver later on.

Repeat patterns are an effective element in
many black-and-white images, whether
deliberately arranged – like shoes on a rack or
roof tiles – or in a natural form like the
patterns left by waves on a beach or a flock of
birds in flight. Every subject also confronts the
photographer with the question of whether
the photo should tell a story and bring a mood
to life or simply document an object. And if
the mood is important, what is it telling us?
What do we need to accentuate to convey its
meaning? If you imagine different  black-and-
white versions of your image while you are
shooting, you are sure to end up taking better
pictures.
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Black-and-white Photography | Learning to See
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Black-and-white Photography | Learning to See

Shapes and lines.
The basic patterns in a
subject attract the
viewer’s attention.

Light and shade. A wide-angle viewpoint, a panorama format and the low
sun transform an everyday subject into a real eye-catcher.
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If we compare analog and digital photographic
technology, it quickly becomes apparent just
how much more flexible digital processing
techniques are. An analog black-and-white
negative has already converted all of the colors
present in the original scene into blacks and
grays – in other words, the entire process takes
place without the presence of color at all.
Overall brightness can be influenced by
altering the exposure, contrast can be
influenced to some degree by using different
grades of paper and individual elements of an
image can be accented using dodging and
burning techniques, but that’s all. In contrast,
today’s image processing software, with its
layers, tools and filters, gives us endless ways
to completely “reinvent” an image. 

Colors and Tonal Values

The black-and-white technique you choose will
depend on a number of factors. If you want to
process multiple images, the structured
interface of a RAW converter and batch
processing functionality will help you to achieve
your goals. However, if you tend more toward
spending hours fine-tuning a single image, you
are probably better off converting it later using
Photoshop. Whatever you do, don’t use your
program’s built-in grayscale mode, as this will
simply rob you of  valuable image data.

It is impossible to overestimate the
usefulness of the ability to use the original
colors to emphasize particular grayscale
values. The soft drink still life on the right
demonstrates this principle very nicely.
Converting the original image using
grayscale mode produces a result in which
the green, blue and red cans are almost
indistinguishable, while the real differences
between the tones are immediately apparent
in the individual color channels.

The green channel version is most similar
to the grayscale image, with green and blue
reproduced slightly lighter and red darker.
The red channel reproduces blue almost as
black and red so brightly that it is almost
indistinguishable from the white background.
The most obvious color shifts are in the blue
channel. The blue can in our still life is very
bright, while the label on the bottle has
become so dark that the yellow lettering is no
longer legible. You can achieve these same
effects with black-and-white film using
different colored filters. Red filters are very
popular with analog photographers because

they darken skies and give clouds a dramatic
appearance.

Conversion Using a RAW
Converter 
The earliest sensible time to begin thinking
about converting images to black and white
is while you are viewing and rating your
photos in a RAW converter. The current
market leader in the field of all-in-one photo
workflow tools is Adobe Photoshop Lightroom,
which covers all aspects of image processing
from viewing, rating and sorting images
through processing, output and online
publication. Lightroom also includes a number
of useful tools for creating and processing
black-and-white images. 

Simply select the B&W option in the
program’s HSL/Color/B&W panel, which can
be found in the Develop module. The tool
contains sliders labeled Red, Orange, Yellow,
Green, Aqua, Blue, Purple and Magenta, all of
which can be adjusted independently, giving
you a powerful way to alter the relative
strengths of the grayscale values in your
image. The preview window displays a
grayscale image, but this is actually based on
the original RGB image data, which can be
further processed in ways we will describe
later on. Lightroom cannot process black-and-
white images that have been converted using
another program’s grayscale mode.

Photoshop’s own built-in RAW converter is
called Adobe Camera Raw (ACR) and supports
non-destructive processing for a wide range
of RAW formats. ACR’s own Grayscale tool
offers the same eight sliders as the Lightroom
version and works in exactly the same way.

Conversion During Image
Processing
Most digital photographers use their favorite
image processing program to convert images
to black and white. The following sections
detail the conversion process using Photoshop,
although the steps involved can be duplicated
in just about any other similar program. The
Channel Mixer was the conversion tool of
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How to Create 
Black-and-white Images

All colors look almost identical
in grayscale mode, but the

tonal values shift dramatically
in the individual color channels

Grayscale

Red channel

Green channel

Blue channel
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choice in CS2 and earlier versions of Photoshop,
but has now been replaced by the dedicated
Black & White dialog. Photoshop Elements has
no similar tool built in, but can be upgraded
using the powerful Elements+ plug-in, which is
described in detail in Issue 1 of c’t Digital
Photography.

If you still want to use the Channel Mixer
(Image > Adjustments > Channel Mixer), click
through the three color channel images first to
give yourself an idea of how best to adjust
your image. The tool itself allows you to weight
the color channels individually and also offers
a range of presets that simulate popular black-
and-white filter effects, including blue, green,

orange, red, yellow and infrared, which
brightens green tones to produce the well-
known dream-like “wood effect”. 

The dedicated black-and-white tool (Image
> Adjustments > Black & White) works in a
similar but more subtle way. To convert an
image using this tool, first create a new
adjustment layer (Layer > New Adjustment
Layer > Black & White). Adjustment layers allow
you to apply effects that you can readjust or
undo at any time without affecting the original
image data. In fact, the effect is similar to
positioning a filter in front of the camera’s lens –
the immediate view looks different in spite of
the fact that the original image hasn’t changed. 

The preview image will now be displayed
in black and white, although the original RGB
image still forms the background layer. This
allows you to selectively and subtly access and
alter the individual colors in the original image
using the tool’s sliders. The effect will be the
same as the one produced by the non-layer-
based Channel Mixer tool. 

Photoshop Elements includes its own
Enhance > Convert to Black and White tool,
which offers a range of preset effects (Infrared,
Newspaper, Portrait, Scenic Landscape etc.)
and sliders for adjusting overall contrast and
the intensity of the red, green and blue
channels.

Dedicated Software

If you are serious about black-and-white
photography, you will sooner or later come
across specialist software like Silver Efex by Nik
Software or LightZone by Light Crafts, which is
also available for Linux. 

LightZone uses the same basic principle of
weighting the different color channels to
produce a pleasing black-and-white image,
but also has other tools up its sleeve, such as
the ZoneMapper, which offers a very intuitive
alternative method for adjusting tonal values.
The program is capable of simultaneously
addressing and adjusting multiple image
parameters without having to confirm each
step individually, and allows you to  apply
effects to selected image areas. It also includes
a range of preset Styles that automatically
apply a series of processing steps to produce
a particular result. 

Silver Efex is a Photoshop/Lightroom plug-in
designed expressly for converting color images
to black and white, which it happens to do
better than any other software we know. Once
installed, the plug-in is available in the host
application’s filter menu. The tool emulates
various black-and-white development
methods, filters and paper grades and is so
intuitive to use that it has helped many a dyed-
in-the-wool analog photographer to make the
transition to digital. It includes more than two
dozen really useful preset effects and a range
of color filters and sliders for fine-tuning tonal
values, making it quick and easy to produce
great basic monochrome images.
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Lightroom’s grayscale tool offers sliders for
adjusting eight different ranges of tonal
values

Adobe Photoshop Elements includes an
intuitive black-and-white conversion tool



Using Local Contrast to 
Create Tension
Fine-tuning an image often involves
processing individual image areas separately.
If you select a detail before you have created
a new adjustment layer, Photoshop
automatically creates a layer mask of the
selection. Layer masks are separate grayscale
images and are a boon to the black-and-white
workflow. The currently active effect is applied
at full strength in the white areas of the mask,
while the black areas remain transparent and
produce no effect at all. 

The really clever thing about masks is that
you can apply any filters or effects that you
want to them, and you can create additional
transparent or opaque areas at any time using
black and white brushes. Not only that, but a
layer mask is in fact a full 8-bit grayscale image
with 256 different tonal values, which means
you can apply different levels of opacity to
produce soft transitions between various
image areas. 

Our Golden Gate Bridge example shows
just how simple it is to use layer masks to
produce cool effects. In the red channel, the
sky is well defined, while the sea and the
seashore disappear into detail-free shadow.
The other two channels show the opposite
effect, with good foreground detail and a pale,
uninteresting sky. The solution is to use two

layer masks. In the first, select the sky and the
bridge (using either the Magic Wand or the
Polygon Lasso) and increase the effect of the
red channel in the selections to 100% and in
the rest of the frame to 0%. Now simply invert
the selection in the second mask to accentuate
the midtones in the foreground. The result is
an image with great overall contrast.
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LightZone is capable of simultaneously
addressing multiple image parameters, such

as Color Balance and the ZoneMapper
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Silver Efex works on the same principles as a traditional black-and-white darkroom, offering various processing and paper grade effects, as well
as emulating optical filters. The major difference is that the software is much more powerful than a darkroom ever was.

In the red channel, the sky and the bridge appear especially tactile, but the sea and the seashore are much too dark. In
the other two channels, the foreground is better defined, while the sky appears a dull gray. Applying two layer masks
that accentuate the best parts of each provides us with the balanced, high-contrast image shown on the far right.
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Conversion to black-and-white is the first and most important step inour workflow. This is the stage at which the image is given the basicmood that determines the effect it will have on the viewer, and youwill need some practice until you become accomplished atperforming the steps involved. Take a look at our sample images ofVenice and try to work out the time of day and what the weather wasdoing when they were shot. These images contain everything from adiffusely lit, cloudy view to bright midday sun or a dramatic stormysky. It is tempting to go for a dramatic look when you are making your

first attempts at black-and-white conversion, but our “red filter” imagewith its black sky soon becomes tiresome to look at. Use effectscarefully and make sure that you end up with a good balance of graytones in your converted image. There are, of course, no hard and fastrules for this type of work – just as you capture a specific moment anddetach it from time when you release the shutter, you can add afurther level of abstraction during processing that creates acompletely new image. Try converting some of your favorite colorimages and see what you end up with. 

Different Versions of a Single Photo 

Depending on how they were converted, the various versions of this image convey completely different moods



In view of the amazing tools available for
processing digital images, you could be
forgiven for thinking that it is nowadays
impossible to produce a poor print. The fact
that many images still have no soul is often
due to a lack of balanced tonal values or poor
framing. Once an image has been converted,
the next step is to straighten and crop it, and
remove any unwanted distortion. We assume
that you usually apply these steps to your
color images anyway, so we won’t go into any
further detail here. The exposure corrections
that we do describe are, however, much more
monochrome-specific. 

You should immediately discard any
seriously under- or overexposed images, but
any well exposed image can benefit from the
adjustments we will be discussing. The
necessary tools can all be found in the

Photoshop Image > Adjustments menu.
Always create a new adjustment layer to apply
an effect. Our aim while shooting was to
capture as much image data as possible, and
we now want to distribute that data to
perfectly fill the entire spectrum between
black and white. Any data that a scan or
exposure didn’t capture in the first place is, of
course, lost forever.

The simplest way to adjust exposure is to
use the Brightness/Contrast tool to make the
entire image brighter or darker, although
this rarely actually improves a photo. If you
adjust brightness globally you will also have
to adjust contrast (i.e., the difference in
brightness between the brightest and
darkest point in your image). You can often
achieve acceptable results by adjusting
these two settings together, but the

simplicity of the algorithms involved means
that the results are not particularly
spectacular. 

Before we go into detail on the more
complex tools available, let’s look at an
example of how under- and overexposure or
changes in contrast can affect the look of an
image. The relationship between the two
ideas is simple, but true understanding often
makes the difference between  an
acceptable photo produced by trial and
error and a well thought-out black-and-
white image.

Adjusting contrast produces “high-key” or
“low-key” images, while adjusting global
brightness alters highlights and shadows to
the same degree. Some tools allow selective
adjustments to specific image areas without
affecting the rest of the frame. 
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Optimizing Black-and-white Images 

Each of these three versions of a single image has the same brightness but a different level of contrast.
All three tone curves intersect with the center point of the graph, but each has a different gradient.



The Levels Tool

The Levels tool is much more efficient than
the Brightness and Contrast sliders and
includes a histogram that displays the
distribution of tonal values in your image. The
histogram consists of 256 points on a scale
that corresponds to black on the left and
white on the right. The height of each “peak”
is proportional to the number of times that
particular grayscale value occurs in the image.

The shape of the histogram curve shows
where and how you need to adjust your image
using the White Point, Black Point and Gamma
pointers. An underexposed image shows more
pixels grouped toward the left-hand end of the
scale and virtually no pixels toward the right-
hand (white) end. The range of tonal values in
the image increases if you move the white
point slider toward the center of the scale. This
spreads the available tonal values more evenly
throughout the  image. If an image is
overexposed, you will need to move the black
point to the right to balance its tones.

Low-contrast images lack punch, and the
tonal values are grouped in a narrow range in
the center of the scale. In this case, it is best to
shift both pointers toward the center. This
makes the curve flatter and wider and gives
the image more verve. The center pointer in
the Levels dialog adjusts gray balance –
i.e., midtones only. A shift to the left brightens
the midtones while moving the pointer to the
right darkens them. The adjustments you
need to make will also depend on the type of
output medium you plan to use.

Make sure that you don’t delete any tonal
values while you are making your
adjustments. There are often areas with very
few visible pixels to the right and left of the
main hump in the curve, and it is these that
contain the important highlight and shadow
details that breathe life into a black-and-white
image. If you press the Alt key while shifting
the black and white point markers, Photoshop
displays the parts of the image that your
adjustment will clip in real time – a really
helpful feature.

Tone Curves

The Curves tool allows you to delve even
deeper into the tonal values that make up
your image, but requires you to take more
care while doing so. The tone curve shows the
relationship between input and output values
and forms a straight 45-degree line at its
default setting. The input value corresponds
to the current brightness setting and is shown
on the X axis, while the corresponding output
value (i.e., the effect of the adjustment) is
shown on the Y axis. Here too, the darker
values are located on the left and the brighter
ones on the right. Photoshop Elements does
not have a built-in Curves feature, but can be
upgraded using plug-ins such as SmartCurve
or Elements+.

To understand how curves work, take a
close look at how adjustments to the
brightness and contrast sliders affect the
shape of the curve. The curve for a bright
image is positioned toward the top of the
graph, while a darker image has a curve that
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In these three images, we altered the brightness without changing the contrast. In this case, the tone
curve is shifted up or down parallel to the original curve while the gradient remains the same.



is positioned lower down. In this case, the
gradient of the curve remains the same. In
other words, the Contrast slider moves the
line on the graph and alters its gradient but
doesn’t change its shape, which is why
adjustments to brightness and contrast are
known as linear adjustments.

Things get more exciting when we move
away from linear adjustments and begin to
selectively adjust specific tonal values. A high-
contrast image with only a narrow range of
midtones looks more harmonious if we
brighten the shadows and darken the
highlights. This involves spreading the
existing tonal values to cover a broader range
of output values and unavoidably “squeezes”
the midtones together. Darkening the
shadows and brightening the highlights
produces an S-shaped curve, which helps to
breathe life into low-contrast images by
accentuating the details in the midtones. An
S-curve compresses but preserves highlight
and shadow detail. 

Adjusting the shape of the tone curve is a
simple matter of grabbing and moving the
point you wish to adjust with your mouse.

Photoshop allows you to draw tone curves
freehand, but care is required, as it is difficult
to tell what the results will look like. You can
also save a curve, which saves you having to
perform the same curve manipulations
multiple times if you are processing a series of
images taken under the same lighting
conditions. 

Shadows/Highlights

The Shadows/Highlights tool (in the Image >
Adjustments menu) is another great
Photoshop tool for adjusting tonal values. The
tool adjusts the tonal values of individual
pixels relative to their surroundings and,  in its
Show More Options view, offers a wide range
of adjustment options. Amount is the most
important Shadows slider, but take care when
adjusting the value, as the effects it produces
can quickly get out of hand. Start at a value of
about 10% and increase its value slowly in 5%
steps. There is usually no visible improvement
in detail contrast above about 20%. The Tonal
Width setting determines which differences in
tonal values are addressed, and the Radius

setting defines the area the effect is applied
to. If you want to stick to adjusting only the
darker pixels, you need to use Radius values
of 30 or less.

The settings in the Highlights section work
in the same way, but darken the affected
pixels instead of brightening them. There is
also a dedicated Midtone Contrast slider that
really does only affect midtones and
effectively prevents burned-out highlights or
swamped shadows. Analog darkroom
technicians always longed for such a tool, and
were only ever  able to produce this type of
effect by performing extremely complex
dodging and burning procedures.

Not all images require tonal values to be
distributed evenly – dark details in a photo
shot in fog, for example, simply spoil the
mood of the shot. However, it is still important
to ensure that detail doesn’t simply disappear
into the mist, and the solution is to perform
selective darkening. Again, the trick here is to
apply the effect subtly and keep your images
realistic-looking. Images in which bright tones
dominate are described as “high key”, while
the term “low key” is used to describe images
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in which darker tones determine the overall
mood. Spreading all the available tonal values
to distribute them more evenly is an easy
approach to take but seldom produces results
with an effective range of contrast. Even the
darkest low-key image contains a wealth of
interesting detail, and trying to “optimize”
tonal values in such an image is often a
mistake.

Zone Mapping

The most complex way to adjust tonal values
is using “zone mapping”, which is based on a
system developed by Ansel Adams.
Generations of photographers have admired
Adams’ fantastic landscape photographs and
his theories regarding complete control of
photographic contrast – even if no-one has
ever really understood them! His system
involved dividing an image into eleven zones
labeled using Roman numerals from zero
(indicating black) to X (indicating white), but
only worked if each negative was individually
developed in a way that corresponded to the
exposure parameters used to shoot it. It is also

easy to forget that the quality of Adams’
images stemmed from his use of large-format
film. High-resolution medium-format digital
camera backs or 8x10-inch negatives
inevitably record more detail than a full-frame
sensor or film. It is only recently that digital
processing techniques have enabled us to
reproduce a level of detail and expression that
approaches that of large-format images. 

The zone mapping functionality built into
programs like LightZone and Silver Efex makes
it possible to select a specific grayscale value
and apply it to selected target zones. It sounds
complicated, but is, in fact, a very intuitive way
to make adjustments, especially in view of the
real-time preview image, which immediately
shows you the effects of your alterations. The
Zone Finder tool uses colored markings in its
own preview window to highlight all the areas
in your image that belong to the currently
selected zone. 

Dodging and Burning

All of the adjustment techniques we have
discussed so far are applied either to the

entire image or to areas of the image that you
have selected in advance. The manual dodge
and burn tools that are part of just about
every image processing program are
designed for making fine adjustments to
extremely localized image areas. The names
of these tools are the same as their equivalent
analog darkroom techniques, and Photoshop
users who have darkroom experience often
find it easier to get to grips with them. Some
black-and-white photographers process their
images using just the Dodge and Burn tools
and without using selections, layers or
masks – and the results speak for themselves. 

To underscore what all this means, let’s
take a quick look at how analog darkroom
techniques actually work. Analog images are
printed using an appropriate combination of
exposure time and paper grade, which often
produces images with areas  that lie between
the resulting gradations and are either too
bright or too dark in the final print. Dodging
(i.e., brightening) part of an image is achieved
by holding either your hand or a piece of
opaque card between the light path from the
enlarger lamp and the area you want to
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The Levels tool has three sliders
with which you can expand or
contract the overall distribution of
tonal values or adjust color balance
by selectively adjusting the
intensity of shadows, highlights
and midtones. The original image is
shown on the right and the
adjustments in the others are
highlighted in blue.
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brighten. The parts of the image thus shaded
will be brighter in the finished print. Burning
has the opposite effect and is used to give
areas that are too bright an extra dose of light
during the exposure. Gently ”fanning” your
hand or the mask while dodging or burning
ensures that the transitions between
manipulated and non-manipulated areas
remain invisible. 

Compared with analog techniques,
dodging in Photoshop is child’s play – and you
only have to apply the effect once to produce
whole sequences of identically altered
images. The Dodge and Burn tools work on a
destructive basis, so it is safer to apply them
to a separate layer. Select Overlay blend mode

and activate the Fill with Overlay-neutral Color
option. 

You can now brighten or darken your
targeted areas using the Dodge and Burn
tools. The effects of each tool are controlled
using the settings in the toolbar, which allows
you to apply them to shadows, highlights or
midtones. You can also adjust the size and
hardness of the brush tip. We recommend
that you start using low values and work
slowly up to the values that produce the effect
you are looking for. 

The best way to see the effects of your
adjustments is to hide all the other layers.
Burned areas will appear darker and dodged
areas brighter on the adjustment layer.
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The Curves tool is a sensitive instrument for adjusting tonal values. Low-contrast
images often benefit from the application of an S-curve.



Because the 50-percent gray color of a layer
in Overlay mode has no effect on the image,
we can precisely target the details and
textures that we want to manipulate. It is a
good idea to create a new layer for each step
in the process, as you can then use the
opacity slider to fine-tune your adjustments
and alter each effect individually later if you
need to. 

If you want to dodge or burn very fine
textures, we recommend that you make a
selection first and then use it to work in a new
layer. Use a soft edge for selections in broad-
based patterns to keep the transitions
between manipulated and non-manipulated
areas invisible.

These tools enable you to selectively
manipulate the tonal values anywhere in
your image. The control point functionality
built into Silver Efex works in a similar way
and, once you have performed your basic
processing, you can use it to fine-tune the
details to your heart’s desire. Control points
can be placed individually or grouped, and
you can selectively adjust brightness, 
contrast and structure for both. There are
additional contrast sliders for amplifying
blacks and whites, as well as for manipulating
the fine structure of your selected detail.
Using control points requires a little practice,
but the results are more than worth the effort. 
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High-contrast images, such as night-time street scenes, look more
balanced if you brighten the shadows and darken the highlights
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Applying the Burn tool gives the reeds in the foreground much better detail definition

Fantastic black-and-white effects: the control point functionality built into
Silver Efex is perfect for giving your monochrome images real polish
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A black-and-white rendition is often better for
accentuating the character of a portrait subject

Ph
o

to
: h

u
n

ta
, s

h
u

tt
er

st
o

ck
.c

o
m

Not every photo of a person is a portrait. The art of portrait
photography involves capturing and accentuating a person’s
character. Traditional portrait photos are shot using a short to
medium telephoto lens, a three-quarter view of the subject
(i.e., with the subject looking diagonally out of the frame) and
a neutral background that doesn’t draw the viewer’s attention
away from the subject. But these are merely guidlines, and you
can set up your own portrait shoots however you like.

A well-lit studio portrait looks calm and dignified, but often
posed as well. In contrast, photos shot on location are seldom
perfectly lit, but usually create a much more lively image of the
person being portrayed. It is often preferable to use and

enhance natural light than it is to attempt perfection in a
controlled studio environment. The photo shown below is an
extremely successful location shot.

The lack of color in a monochrome portrait often helps to
accentuate the subject’s own physical characteristics, whether
these are the folds in an older person’s skin, the glint in a
winning athlete’s eyes or the soft expression on a child’s face.
Pay special attention to the skin tones when converting
portraits to black-and-white – a relatively large red component
in the channel mix gives them a softer, more even look. In
contrast, increasing the blue component can make even the
palest of faces look freshly tanned.
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If you want to make your black-and-white
images even more striking, you can try
applying some special effects. Since the
invention of the medium, photographers
have been looking for ways to alter or
manipulate their results, and some of today’s
techniques are as old as photography itself.
Once the principle of silver halide-based
development had been established, there was
no looking back. In addition to these older
techniques, a number of processes that were
developed in analog darkrooms can now be
simulated digitally. The following sections
describe some of the best.

Antique Effects

If you look closely at prints from the 1920s and
1930s, you will see that they often contain
neither black nor white, and more often than

not show a dark brown image printed on a
light brown background. Ultraviolet radiation
and sulfuric gases gnaw at the blacks over
time and the white background simply
yellows with age. Generations of
photographers used sepia toning and
tea-based solutions to deliberately give their
images an antique look, but the 21st century
photographer only has to activate the Tint
option in Photoshop’s Black & White dialog to
adjust the  hue and saturation of a tint using
the tool’s built-in sliders. If you are tinting
particularly sharp images, applying a blur filter
first helps to accentuate the effect.

Once you have found the right tint color,
you can simulate the effects of years of UV
radiation. First, set the foreground and
background colors to black and white in the
toolbox and then navigate to the Render >
Clouds command in the Filter menu. This

creates a new layer filled with a random
pattern. Set the new layer’s opacity to 10%
and observe the effect this has in the preview
window. You can also simulate film grain by
applying a Noise filter to the image layer.
Make sure that images you process this way
are suited to the look of a bygone age.

Colorization

Before the invention of color photography,
hand colorizing black-and-white photos was
a widespread art form. People used albumen-
based paints and brushes or cotton swabs to
apply layers of transparent color that were
absorbed into the photo paper. Although
they weren’t particularly realistic, the resulting
colors nevertheless had a certain romantic
charm. 

Black-and-white Effects 

The mystical effect in this image was produced by applying the right combination of digital effects
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There are various ways to simulate this
type of effect digitally. If you want to color an
entire image, first create a copy of the
background layer and convert the original
background layer to black and white.
Reducing the opacity of the copied layer
then simulates the effect of applying a
transparent color to the image – 30% opacity
is a good staring point for most subjects. The
dreamy look in many hand-colored photos is
a result of the paint reducing image
sharpness. This effect can also be simulated
by applying the Gaussian Blur filter to the
color layer. The overall effect is more realistic
if produced by superimposing a transparent
color layer on an opaque image layer, rather
than the other way around. Once you have
found the right basic effect, you can fine-
tune the individual colors.

You can then optimize your results by
adjusting opacity and blend mode for one or
other (or both) layers. Using the Soft Light
blend mode for the upper, color layer adds a
feeling of depth, and brightening the
background layer a little while preserving

contrast enhances the overall mood. It is
worth making the extra effort to manually
color your black-and-white images, as no filter
or plug-in can automatically generate such
convincing effects.

Another effective and eye-catching
technique involves coloring selected details in
a black-and-white image. The more striking
the image detail, the more effective a dab of
color will be.  

You can colorize details either by coloring
a selection in an image that has already been
converted or by masking a detail before
performing the conversion. Try it out – it’s
amazing how you can use color to steer the
viewer’s eye toward a particular detail. This
technique is especially effective in busy
images in which many details compete for
your attention. If you mask a single-colored
detail during conversion, you can adjust the
tonal values and framing in the finished image
around it. If you compose your images with
this kind of technique in mind, your photos
will provide you with perfect material to
experiment with.

Graphic Techniques
There are various ways to create graphic
black-and-white images. For example, lith

Color details can be widely spread within the frame as long as the overall mood is consistent

If you want to delve deeper into the
fascinating world of black-and-white
photography, these two books are well
worth a closer look:

Black-and-white composition
Torsten Andreas Hoffmann,
The Art of Black and White Photography,
ISBN-13 978-1-93395-227-7 

Fine art black-and-white
photography
Ralph Lambrecht/Chris Woodhouse,
Way Beyond Monochrome, 
ISBN-13 978-0-240-81625-8

Further Reading



The Tint tool is part of the Black and White
dialog and includes sliders for adjusting
Hue and Saturation
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prints use a combination of standard black-
and-white paper and lithographic developer
to produce prints with fine, bright highlights,
unusually dark shadows and virtually no
midtones. If all the development parameters
have been well coordinated, the paper will
display a coarse grain structure and a subtle
colored luster. Such effects involve complex
tinkering in the darkroom, but can be
reproduced reliably and effectively using
Photoshop.

The process begins with a black-and-
white image in RGB mode. Make two copies
of the background layer and name the lower
one “highlights”  and the upper one
”shadows”. Now switch the blend mode of
the highlights layer to Multiply to allow the
shadows layer to show through. Use the
Curves tool to drag the lower end of the
shadows tone curve upward until the darker

tones disappear (equivalent to an output
value of about 100). Now move the upper
end of the tone curve in the highlights layer
to the left until all tonal values above 100 are
white (i.e., with an output value of 255).

Our Lith print now receives its final polish
in the form of grain and tonal fine-tuning.  Use
the Hue/Saturation tool’s Colorize option to
apply a sepia tint to the highlights layer with
a Hue value of about 30 and a Saturation value
around 20. You can now add grain to the
shadows layer using the Artistic > Film Grain
filter – and that’s it.

Solarization is another popular graphic
approach to developing black-and-white
images. Photoshop offers various approaches
to this technique, the simplest of which is to
use the eponymous Stylize > Solarize filter.
The filter itself has no adjustment options, but
you can alter the effect manually using the

opacity slider in the Edit > Fade Solarize
dialog. 

You can gain  better control over the
process if you first create a new Curves layer
and move the left-hand end of the curve
upward until all the pixels are displayed in
black. The effect can then be modulated by
adjusting the shape of the curve. A U-shaped
curve is equivalent to the standard filter effect,
and various tweaks to the overall shape
produce different effects. Try it out and see
what you come up with.

Infrared

Infrared analog film has a sensitivity range
that extends to 900nm at the long-wave end
of the scale. In other words, it is sensitive to
near infrared (NIR) frequencies that the
human eye cannot see. Because the visible
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look.
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spectral region makes up more than 80
percent of the total luminance, it is necessary
to use an appropriate filter to block these
wavelengths if we want to be able to see the
infrared effect. The result is a photo with a
unique look that cannot be simulated using
any other tools or techniques. Green foliage
is reproduced in bright white and the blue of
the sky appears very dark in contrast,
producing wonderfully dramatic landscape
images. Portrait photographers like the soft
skin tones that infrared effects produce.

The only way to produce “real” infrared
images with a digital camera is to use an
optical infrared filter attached to the lens,
although it is possible to produce similar
effects digitally for suitable subjects. CS3 and
later versions of Photoshop have a dedicated
Black & White Infrared option in the Image >
Adjustments > Channel Mixer dialog. Older

versions of Photoshop (and other programs)
require a little more effort to achieve the
same effect: first make a copy of your image
and activate the Channel Mixer dialog.  In
order to simulate bright green tones against
a very dark sky, you then need to set a high
Green channel value and a negative Blue
value in Monochrome mode. Red +20, Green
+150 and Blue -100 are good values to start
out with, but  vary widely from subject to
subject.

The next step is to apply the Gaussian Blur
filter. A Radius setting of 0.5 pixels produces
subtle halos without reducing visible
sharpness too much. As a final touch, create
a new layer in Overlay mode and activate the
Fill with Overlay neutral color (50% gray)
option. Applying the Film Grain filter to this
layer gives your image an authentic “grainy”
infrared look.

Conclusions

Digital technology gives us endless ways to
manipulate and enhance images after
shooting. Black-and-white conversion is one of
the more significant ones because the
additional degree of visual abstraction it
provides makes it easier to control the effects
your images have on the viewer. The
importance of black-and-white functionality is
documented by the fact that every image
processing program, from entry level upward,
has its own monochrome conversion tool. If
this article and your own experiments have
awakened your curiosity, it is definitely worth
taking a closer look at Silver Efex. Whichever
tool you choose, a good photographic eye and
a little practice  are all you need to start
producing your own impressive black-and-
white images. (pen)  c
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Dr. Klaus Peeck

Bridge and All-weather
Camera Test

This issue’s camera test covers two 30x optical wide zoom
bridge cameras and a ruggedized all-weather ultra-compact.
Sensor resolution continues to increase in these classes 
of camera and none of the models we tested has less than 
14 megapixels under the hood.



The Tough TG-810 from Olympus is a
weatherproof compact with relatively

dark 5x zoom with an equivalent focal length
range of 28-14 mm. The camera is waterproof
to a depth of 10 meters and resistant to falls
of up to two meters. The robust all-metal body
is capable of withstanding pressure of  up to
100 kilograms, which is handy if you like
carrying your camera in your hip pocket.
When switched off, the TG-810 covers the lens
with a metal lens cover which, thanks to the
periscope-type lens, is the camera’s only
external moving part. 

Our other two test candidates belong to
the superzoom category and both offer DSLR-
type bridge bodies with 30x, f/2.8-5.6 zoom
lenses. The Fujifilm  FinePix HS20 EXR offers a
particularly impressive manually zoomable
24-720 mm (equivalent) lens, while the Sony
Cyber-shot DSC-HX100V zooms “by wire”
using the lens ring or the standard zoom lever.
The Sony’s 27-810 mm zoom range extends
slightly further than the Fujifilm model, but
has a slightly narrower widest-angle setting as
a result.

Even More Megapixels

We were pleased to see Canon’s recent
release of the Powershot SX230 with “only“ 12
megapixels of sensor resolution and
commensurately improved high-ISO
performance. Unfortunately, pixelmania
continues to dominate the market and all of
our current test candidates are equipped with
sensors that capture 14 megapixels or more.
Both bridge cameras have 16-megapixel
back-illuminated CMOS sensors. With the
exception of the Fujifilm, with its slightly
larger 1/2" sensor, all of our test cameras have
to make do with tiny 1/2.3” sensors. The
combination of a large number of pixels with
such a tiny surface area reduces the light
sensitivity of each individual receptor and
delivers a relatively weak optical signal that is
sometimes barely distinguishable from the
sensor’sown background noise (see the
Signal-to-noise ratio column in the table). The
camera’s firmware therefore has to strongly

amplify the signals produced by the sensor,
and this inevitably produces more noise
which then has to be digitally removed –
again reducing overall image quality.

All this is nowadays dealt with by specially
developed noise reduction algorithms that
are ably supported by today’s increasingly
powerful processors. But no matter how
powerful your camera’s processor is, it still
cannot work magic! Even the most
sophisticated algorithm cannot reconstruct
details that are simply missing in a noisy
image with poor detail definition. Camera
firmware is instead programmed to selectively
sharpen high-contrast image areas and
equalize the effects of low-contrast areas and
monotone shapes. The theory is that the
detail that is probably present in high-contrast
areas is automatically enhanced while
simultaneously softening potentially irritating
noise artifacts in detail-free, low-contrast
areas.

The result is a soft, almost mushy look that
is typical of images produced by today’s
highly integrated do-it-all digital wonders. In
extreme cases, these effects take on an almost
water color-esque character, which can lead
to very disappointing results when it comes to
capturing fine details such as grass, leaves or
the crevices in a brick wall. The alternative
would be to use less aggressive noise
reduction algorithms and to risk producing
images with slightly more noise but markedly
better detail definition.

Viewed in the cold light of day, all of our
test cameras have poor noise handling
characteristics, which is no surprise in view of
the huge resolution packed into such tiny
sensors. ISO 400 is the maximum tolerable
setting for making small prints or viewing

images in full-screen mode for all of these
cameras. Ironically, the enlargements that the
manufacturers advertise as the main
advantage of their high pixel counts are
unusable at ISO values above 200. At higher
values, all of our test cameras battle with more
or less heavy-duty noise modulation artifacts.
This situation is often exacerbated by cameras
that have no Auto ISO feature and that simply
crank up the ISO value (and with it the level of
image noise) even further in low light instead
of setting a limit. 

Features

The weatherproof Olympus offers a typical
feature set for a camera of its class, with the
emphasis on automation. Semi-automatic and
manual exposure settings are not part of the
deal and there are no user-controllable
settings for sharpness, contrast or the degree
of noise reduction. This camera doesn’t even
have center-weighted metering functionality
or manual white balance settings, and only
just missed a “poor” rating in the features
category. Continuous shooting mode
wheezes in at a meagre 0.6 frames per second
(fps) burst rate. 

Our two bridge cameras don’t demand as
many compromises, and both offer a full set
of manual and semi-automatic exposure and
image parameter settings, including variable
noise reduction, flash compensation, white
balance fine-tuning and, in the case of the
Sony, white balance bracketing and shift. The
HS20EXR offers its own film simulation
bracketing mode that reproduces the look of
old-school Fuji slide films and also includes a
dynamic range bracketing mode. Both
cameras offer fast continuous shooting. The
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Our test shot contains some serious
technical challenges as well as some

random objects that were selected for 
their high recognition value. The details

mentioned in the test results 
are outlined in red.



HS20 can shoot up to 32 JPEG frames at
between 3 and 11 fps, while the Sony offers
between 2 and 10 fps or up to 10 shots. As
usual in burst mode, you have to wait a while
at the end of a burst while the camera saves
the captured data, and the Fujifilm was
particularly slow in this respect.

Camera monitors are getting better all the
time. The HS20EXR has a 460,000-dot, 3-inch
screen that is more than adequate for judging
overall image sharpness, but the Sony takes
the prize with its ultra-sharp 921,000-dot
monitor. Both bridge cameras’ displays are
tiltable, which makes overhead or low-level
shooting much easier. They both also have
electronic viewfinders, but with such low
resolution that they are only really any use in
an emergency – for example, if the ambient
light is too strong to use the monitor
effectively.

The HS20EXR has a 58mm filter thread and
a TTL flash shoe and, to our surprise, the
Olympus is capable of wirelessly controlling
Olympus system flash units. Its already
commendable underwater capabilities can
also be extended to a depth of 40 meters
using the PT-051 accessory underwater
housing.

Follow-on Costs

Not surprisingly, the Olympus’ 925 mAh, 
3.7-volt battery is not very long-lasting,
especially in view of the large, energy-
hungry monitor. If you plan to use it for long
trips, it is a good idea to acquire an
additional battery or two. Third-party
batteries are fairly cheap these days and
Olympus hasn’t built original equipment
recognition circuitry into this particular
model. The Sony only recognizes original
Sony batteries, but the 6.8-volt model used
in the HX100V provides twice as much
power as the Olympus and even displays the
remaining power in terms of minutes. The
Fujifilm runs on four AA-size rechargeable
cells, and offers the most potential battery
power of our test models – provided, that is,
that you use batteries with a flat discharge
curve like Sanyo’s eneloop range. This type
of battery also has a long shelf life and loses
virtually no charge when not in use. Fujifilm
supplies only standard, non-rechargeable
batteries with the camera, so users who
don’t already own them will have to
purchase rechargeable batteries and a
charger.

Battery chargers are provided with digital
cameras much less frequently than they
used to be, and most models that use Li-ion
batteries force their owners to charge the
batteries in-camera or using a computer by
way of a USB cable or mains adapter. This is
a practical solution with regard to the
compatibility of USB chargers with car
electrics, but means that you cannot use the
camera away from your power source 
while the battery is charging. Camera
manufacturers sell separate (often
expensive) dedicated chargers, although
universal chargers can be found that have
either variable pin configurations or
replaceable battery compartments for
specific battery models. If you do decide to
use a universal charger, please make sure
that you purchase one made by a reputable
manufacturer and not a cheap Chinese
model with dubious electrical safety
standards.

The memory built into most cameras is
negligibly small, but SD cards have recently
become virtually standard, making memory a
relatively cheap factor in the cost of running
a digital camera. All of our test models are
compatible with SDHC memory cards and the
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Bridge and All-weather Cameras: Test Results, Part 1
Relative center 
resolution 
(ISO 100, wide-angle)
better >

Diagonal resolution
(ISO 100, wide-angle)
[lp/h]
better >

Center resolution
(ISO 400, wide-angle)
[lp/h]
better >

Diagonal resolution
(ISO 400, wide-angle)
[lp/h]
better >

Center resolution
(ISO 800, wide-angle)
[lp/h]
better >

Diagonal resolution
(ISO 800, wide-angle)
[lp/h]
better >

Center resolution
(ISO 1600, wide-angle)
[lp/h]
better >

Diagonal resolution
(ISO 1600, wide-angle)
[lp/h]
better >

Fujifilm FinePix HS20EXR
Olympus Tough TG-810
Sony Cyber-shot 
DSC-HX100V

Resolution was determined visually in units of vertical line pairs [lp/h]. The larger the value, the sharper the image.

1480
1300

1470
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1322
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1033

1045
758

1080
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637
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Bridge and All-weather Cameras: Test Results, Part 2
Contrast
range/subject range,
ISO 100 
[in f-stops]
better >

Contrast range/
subject range,
ISO 400 [in f-stops]
better >

Contrast range/
subject range,
ISO 800 [in f-stops]
better >

Contrast range/
subject range,
ISO 1600 [in f-stops]
better >

Contrast range/
subject range,
ISO 3200 [in f-stops]
better >

White balance in
daylight
[Digital values]
< better

Color Checker SG 
Δ E

< better

 Signal-to-noise ratio 
[S/Nx] ISO 100

better >

Fujifilm FinePix HS20EXR
Olympus Tough TG-810
Sony Cyber-shot 
DSC-HX100V

Larger signal-to-noise ratio values indicate better image reproduction with less unwanted noise.
Visual noise” is a phsysiologically-based judgement of how “irritating” certain image noise artifacts appear to the viewer. The values are calculated
based on the intensity, frequency, and color of the perceived noise aritfacts. Values below 0.8 represent virtually noise-free images, values below 2 low-noise repeoduction,  
while values between 2 and 3 represent visible but acceptable noise levels. Values above 3 represent disruptive noise levels. Values of 5 and above represent extreme, unacceptable noise
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Bridge and All-weather Cameras: Test Results, Part 3
Wide-angle 
distortion [ %]

< better

Telephoto
distortion 
[ %]
< better

Wide-angle 
vignetting
[in f-stops]
< better

Telephoto
vignetting 
[in f-stops]
< better

Wide-angle
chromatic 
aberration 
< better

Telephoto 
chromatic 
aberration 
< better

Startup time 
[seconds]

< better

 Shutter lag
(wide-angle) 
[seconds]
< better

 Shutter lag
(telephoto)
[seconds]
< better

Fujifilm FinePix HS20EXR
Olympus Tough TG-810
Sony Cyber-shot 
DSC-HX100V
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0.4
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3.1

0.36
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0.18
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Sony’s slot is also compatible with the
proprietary Memory Stick Duo format.

All of our test cameras have USB 2.0
connectors. Commendably, the Fujifilm has
separate mini USB and A/V sockets, while the
other two have combined USB and A/V multi-
connectors. Sony doesn’t even provide the
required proprietary A/V cable. All three have
built-in HDMI connectors, the Olympus using
the smallest D type and the other two the
slightly larger C type. None of our test models
included an HDMI cable, but these are cheaply
available at any photo or video accessory store.

Video Capability

The days of the traditional consumer
camcorder are numbered, and the
competition in today’s casual video sector
is really between smartphones and digital 
stills cameras.

Having said that, most camcorder
manufacturers can breathe a sigh of relief
when faced with this issue’s test candidates.
Only the Sony produces video footage that is
comparable in quality to that of a camcorder.
Its 50 fps Full HD mode provides excellent
quality clips with virtually no visible rolling
shutter effect, although it does appear more
strongly at 25 fps. Resolution is great, focus
tracking is reliable, the stereo sound is very
good and image stabilization works very well,
even at telephoto settings. Only the slightly
pale color rendition and the audible zoom
motor noises spoil an otherwise excellent
video performance. We would, however, have
liked to see a connector for an external
microphone.

The Fujifilm does offer Full HD video while
Olympus owners have to make do with 720p
footage. The HS20EXR’s clips are only averagely
sharp and suffer from slow focus and exposure
tracking as well as poor image stabilization that
produces serious wobbles at telephoto
settings. Sound is rather muffled and is marred
by the continual audible adjustments made by
the camera’s aperture control system.

The Olympus produces clips with rather
pale colors, heavy contrast and slightly
artificial looking sharpness. Its image
stabilization works acceptably well but the
relatively fast autofocus system tends to
search vaguely for the right setting. The sound
of the zoom motor is unavoidably captured
for posterity in the somewhat muffled and
flat-sounding mono soundtrack.

Our views on each camera’s photographic
strengths and weaknesses are detailed in the
individual camera sections below and all
other details regarding features and
handling can be found in the table at the end
of this article.

Conclusions

This diverse set of cameras produced
surprisingly similar image quality, and we
were able to give all three satisfactory or
good ratings for color reproduction,
exposure sharpness and detail rendition.
Unfortunately, all three have poor noise
characteristics in common, making crops
and enlargements practical only at ISO
speeds of 200 or less – at higher levels, the
noise reduction algorithms simply spoil the
overall image quality.

All of these effects are a result of the
manufacturers’ own decision to squeeze too
many megapixels onto tiny image sensors
which, in addition to the drawbacks already
mentioned, also makes it difficult to stop the
aperture down to usable levels.

These cameras are nonetheless all great
photographic tools if used with these
limitations in mind. Ruggedness, a bright
display and simple handling make the
Olympus a good choice if you are prepared
to accept a slight lack of shooting flexibility.
The motorized metal lens cover is a big plus.

The Fujifilm’s highlights include its
wonderful 30x manually-adjustable 24-
720mm (equivalent) zoom and the EXR sensor
technology that enables the user to extend
the camera’s effective dynamic range. The TTL
flash shoe and the on-lens filter thread also
add to the camera’s plus points. On the
downside, the HS20EXR’s Full HD video mode
is only good on paper, and delivers only
average results with poor image stabilization.

The Sony is the exact opposite and
delivers excellent 50 fps Full HD video
courtesy of, amongst other things, a great
two-stage anti-shake system. Apart from its
mediocre noise handling characteristics, the
camera also delivers in the photo arena and
ended up at the top of the class in our test.
Sony also include GPS, a virtual compass and
various 3D and sweep panorama modes for
the price. The only real annoyance in our test
model was the shutter button, which was
much too easy to release and had a virtually
imperceptible halfway point that resulted in
many an unintentional or prematurely shot
photo. (pen)
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Center resolution
(ISO 3200, wide-angle)
[lp/h]
better >

Diagonal resolution
(ISO 3200, wide-angle)
[lp/h]
better >

Center resolution
(ISO 100, Teleposition)
[lp/h]
better >

Diagonal resolution
(ISO 100, Teleposition)
[lp/h]
better >

CCD resolution
(not measured) 
[lp/h]
better >

Relative center 
resolution (ISO 100, w-a)
/ sensor resolution [ %]
better >

Relative diagonal 
resolution (ISO 100, w-a) / 
sensor resolution [ %]
better >

Resolution dropoff
center / diagonal
(ISO 100, w-a) [ %]
< better 

The logarithmic density, D, represents the camera’s dynamic range in terms of the ratio between the brightness of the subject and the corresponding recorded tonal values. Higher values are better. 
Real subject range represents the range of tonal values contained in an 8-bit rendition of a test image.

1025
–

999

706
–

820

993
934

1122

845
937

1111

1728
1608

1728

86 %
81 %
85 %

56 %
68 %
72 %

34 %
15 %
15 %

 Signal-to-noise ratio 
[S/Nx] ISO 400
better >

 Signal-to-noise ratio 
[S/Nx] ISO 800
better >

 Signal-to-noise ratio 
[S/Nx] ISO 1600
better >

 Signal-to-noise ratio 
[S/Nx] ISO 3200
better >

Visual noise 
OECF20 
ISO 100
< better

Visual noise 
OECF20 
ISO 400
< better

Visual noise 
OECF20 
ISO 800
< better

Visual noise 
OECF20 
ISO 1600
< better

Visual noise 
OECF20 
ISO 3200
< better
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26
26
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21

17

12
14
14

8
–

13

1.8
2.0

1.5

3.9
2.9

2.6

6.0
4.0

3.6

5.3
5.1

4.1

7.4
–

5.2
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Large SLR-format bridge camera with compact
30x zoom, 24mm wide-angle setting and tiny
16-megapixel CMOS sensor.

Good: Robust, rubberized body. EXR sensor with
pushable dynamic range. Precise controls,
including large mode dial, thumb wheel and 4-
way selector with RAW shortcut button. Quick
setting buttons for major functions. Vertically
tiltable 3-inch monitor with good resolution and
wide viewing angle. Automatic infrared
monitor/viewfinder switch. Fast autofocus in
good light up to medium focal lengths and in
macro mode. Face (re)recognition with personal
info database.  Ma nual focus using lens ring, and
Focus Check monitor magnifier and focus scale.
1cm super macro mode. 58mm filter thread. Fast
continuous shooting at 8fps. Motion panorama
(sweep) mode. Selectable automatic upper ISO
limit. Built-in flash with well-balanced close-up
mode. TTLflash shoe. SDXC-compatible card slot
on camera side. Power from AA batteries or mains
adapter.

Not so good: 16 megapixels squeezed into a 1/2"
sensor. Sensor shift image stabilization not very
efficient, especially in video mode. Flash housing
gets in the way of the zoom ring, which doesn’t
rotate smoothly enough. Macro vignetting. Low-
resolution electronic viewfinder. Menus have too
many entries. Autofocus in low light and at long
focal lengths slow and “searches” for subject.
Autofocus sometimes inaccurate, even with
confirm lamp. Manual focus ring too sensitive. No
flash in continuous shooting mode. Data saving
slow. Low-power batteries supplied, remaining
power only displayed near the end of battery life.

Test results: Good maximum contrast at ISO 100,
strong drop-off therafter. Noise characteristics
acceptable below ISO 400, much more obvious
thereafter. Only slight vignetting at wide-angle
and telephoto settings, obvious wide-angle
distortion. Clear color fringing at telephoto focal
lengths. Center resolution OK at ISO 100 for a 16-
megapixel sensor, slight drop-off toward ISO 800.
Strong edge resolution drop-off and weak center
resolution at telephoto settings. Long startup

time for a camera with manual zoom. Slow
focusing at telephoto settings.

Image quality: Warm test-shot tones in daylight
with our test sticker positively orange.
Inconsistent exposure. Sharpness not really
balanced with interference artifacts at diagonal
edges. Detail not really good enough for a 16-
megapixel camera. Moirés on our Siemens star,
the line chart and the sieve. Clean monotones at
ISO 100. Reduced sharpness at ISO 200 with some
ragged edges. Grainy monotones and smudged
edges at ISO 400. Some artifacts above ISO 800,
yellow/green color blots beyond ISO 1600. Full-
screen view OK at ISO 400. Fringing on the
“Imperial” sticker, the text chart and the corner
markers.

Outdoor colors realistic and sharpness good
except at extreme wide-angle settings. Exposure
fairly consistent. Edge artifacts and noise
handling as for our indoor test shot, with paler
colors beyond ISO 400. Considerable loss of detail
and sharpness above ISO 800.

Fujifilm FinePix HS20EXR

ISO 100 ISO 200 ISO 400 ISO 800
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Extremely robust, waterproof and pressure
resistant 14-megapixel ultra-compact with
5x periscope zoom and built-in GPS.

Good: Slightly blocky but easy-to-handle metal
body, water resistant to 10 m, shockproof 
for falls of up to 2 m and resistant to 100 kg 
of pressure. No external moving parts except for
the metal lens cover. Finely adjustable
motorized zoom. Very bright 920,000-dot
monitor that is still usable in bright sunshine.
Precise buttons and useful mini joystick. Clear
menu system with one screen per tab,
additional major function icons at the edge of
the monitor. Fast, precise autofocus, except in
very low light. Two separate Auto ISO settings.
Fast flash recycle time and wireless flash control
for other Olympus flash units. Fast data save
times. Battery/memory card slot on camera’s
side. SDXC and Eye-Fi-compatible. Built-in
virtual compass and help pages.

Not so good: Too many megapixels for a small
sensor. Maximum aperture too small at all
focal lengths. Spongy zoom lever, zoom too

fast and zoom steps too coarse. No viewfinder.
No manual focus. LED lamp only for macro or
video shooting, not as AF-assist lamp.
Autofocus unreliable in low light. Very slow
continuous shooting. No manual white
balance. Weak flash that overexposes close up.
Very power-hungry. Battery can be incorrectly
inserted.

Test results: Good maximum contrast at ISO
100 for this class of camera but with strong
drop-off thereafter. Noise handling only
acceptable at ISO 100, getting quickly worse at
higher values. Slight telephoto vignetting but
generally distortion-free. No obvious fringing.
81% center resolution at ISO 100 with only
slight edge drop-off, declining quickly at higher
values. Telephoto resolution not as good, but
consistent. Fast startup, mid-range shutter lag
at all focal lengths.

Image quality: Tendency to overexposure
resulting in slightly pale but consistent
daylight test-shot colors. Sharpness pretty
good with an area of slight blur at the join with

the circuit board. Detail good for a 14-
megapixel sensor. Few moirés and only very
slight fringing. Clean monotones and edges
with fair texture reproduction at ISO 80  – less
detail and less smooth at ISO 100. Smudged
edges and a loss of texture definition at ISO
200. Detail rendition obviously worse above
ISO 400 with grainy monotones. Additional
luminance noise above ISO 800. Full-screen
view very close to unacceptable at high ISO
values. Heavy artifacts above ISO 1600.
Sprinklings of red and magenta-colored blots
at all ISO levels.

Outdoor shots generally well exposed with
good color rendition. Images flat-looking and
unsharp at widest wide-angle setting,
otherwise good detail rendition up to ISO 100
with obvious drop-off, frayed edges and
grainy monotones above ISO 200. Water
color-esque noise reduction artifacts above
ISO 400 and even paler colors above ISO 800.
No fringing.

Olympus Tough TG-810

ISO 100 ISO 200 ISO 400 ISO 800
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Super-zoom bridge camera with a 30x zoom
range starting at 27 mm (equivalent), an
excellent high-resolution monitor and 50 fps 
Full HD video.

Good: Solid, well-built body with (mostly) well-
positioned controls. Large mode dial,
thumb-controlled jog dial and “zoom by wire”
zoom ring. Finely adjustable two-speed zoom.
High-resolution vertically tiltable monitor with
large angle of view. Autofocus fast and precise in
macro mode and up to medium focal lengths.
1cm macro close focus. Fast continuous
shooting mode and (3D) sweep panorama
functionality. Fast data write times. White
balance shift and three custom memory recall
settings. GPS and compass functionality.
Powerful flash unit with balanced close-up flash.
SDXC and Memory Stick Duo-compatible.
Relatively low power requirement. Remaining
battery time display.

Not so good: 16-megapixel sensor too densely
engineered. Shutter button much too easy to

release with barely detectable halfway point.
Manual focus response sluggish. No filter thread.
Minimum shooting distance 1.75 m beyond 6x

zoom. Low-resolution electronic viewfinder.
Icon/menu system difficult to understand. No
quick menu feature. Not particularly configurable:
fixed JPEG quality and playback settings, button
volume not adjustable. No Auto ISO limit.
Autofocus “searches“ at telephoto settings and is
very slow in low light. No flash in continuous
shooting mode. No flash shoe and long flash
recycle time. Combined battery/memory card
slot. No A/V cable included.

Test results: Very good maximum contrast that
only drops off by one additional stop at ISO 400
and 800. Good noise handling at ISO 100, but
falling off rapidly thereafter. No vignetting
problems and only slight distortion. Fringing
well compensated. Good center resolution up to
ISO 400 for this class of sensor with little or no
edge softness, even at telephoto settings. Fast
startup. Strong wide-angle shutter lag, much
better at telephoto settings.

Image quality: Good daylight test-shot color
rendition, although with warm tones – orange
sticker salmon-colored. Balanced sharpness
and good detail rendition. Tendency to slight
underexposure, grayscale chart poorly
differentiated above level 17. Few moirés.
Clean monotones at ISO 100 with some frayed
edges and some loss of texture. Detail and
texture still clean but not as good at ISO 200,
with some ragged edges. Performance at ISO
400 too dark and with too much contrast and
slight violet color cast – orange label with
obvious color artifacts. Beyond ISO 800
unsharp and with significant luminance noise.
Full-screen view only acceptable up to ISO 400.
Fringing well compensated and few other
artifacts.

Outdoor colors and sharpness good, but slightly
underexposed. Automatic noise reduction
visible but acceptable up to ISO 200 with loss 
of detail and edge and monotone artifacts
thereafter. Overall image quality dull above 
ISO 800. Chromatic aberrations well handled.

Sony Cyber-shot DSC-HX100V

ISO 100 ISO 200 ISO 400 ISO 800
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All-weather and Bridge Camera Test
Manufacturer and Model Fujifilm FinePix HS20EXR Olympus Tough TG-810 Sony Cyber-shot DSC-HX100V 
URL www.finepix.com www.olympus.com www.sony.com
Digitization
Native resolutions (in pixels) 4608 x 3456, 4608 x 3072 (3:2), 4608 x 2592

(16:9), 3264 x 2448, 3264 x 2176 (3:2), 3264 x
1840 (16:9), 2304 x 1728, 2304 x 1536 (3:2), 
1920 x 1080 (16:9)

4288 x 3216, 4288 x 2416 (16:9), 3264 x 2448, 
2560 x 1920, 2048 x 1536, 1920 x 1080 (16:9), 
1600 x 1200, 1280 x 960, 640 x 480

4608 x 3456, 4608 x 2592 (16:9), 3648 x 2736, 
2592 x 1944, 1920 x 1080 (16:9), 640 x 480

Sensor type, effective megapixels / Size EXR CMOS (BSI), 16 Mio / 1/2" CCD, 14 Mio / 1/2.3" Exmor R CMOS (BSI), 16 Mio / 1/2.3"
Image format(s) / Compression rates / Video
format

RAW, JPEG / 2 / MPEG-4 H.264 JPEG / 2 / MPEG-4 JPEG / 1 / AVCHD or MPEG-4

Video: max. resolution [pixels], length, fps Full HD 1080p, 4 GB or 29 min., 30 HD 720p, 4 GB or 29 min., 30 FullHD 1080p, 29 min., 50
Memory card type / average file size3 SD(HC/XC) (+ 20 MB internal) / 5.7 MB SD(HC/XC), Eye-Fi (+ 20 MB internal) / 5.8 MB MS Duo or SD(HC/XC) (+ 19 MB internal) / 4.3 MB
Features
ISO settings auto (100-400/800/1600/3200), 

100, 200, 400, 800, 1600, 3200, (6400, 12800)
auto (80-400) / auto HIGH (80-1600), 
80, 100, 200, 400, 800, 1600

auto (100-1600), 100-3200 in 1/3 steps

Max aperture /Steps / Mechanical image 
stabilization

f/2.8-5.6 / 13 (wide-angle) – 7 (telephoto) / v
(sensor shift)

f/3.9-5.9 / 2 / v (sensor shift) f/2.8-5.6 / 10 (wide-angle) – 4 (telephoto) / v (lens)

Exposure times [s] (30) 4 – 1/4000 (4) 1/4 – 1/2000 (30) 1 – 1/2000
Zoom / Steps / Equivalent focal length range 30x / mechanical stepless / 24-720 5x / 25 / 28-140 30x / 115, 2 speeds (lever + electronic zoom ring) / 27-810
Minimum wide-angle subject distance 
macro / standard 5

1 cm / 4 cm 2 cm (“super macro“), 9 cm / 18 cm – / 1 cm

Focusing / AF focus areas / AF-assist lamp AF (one-shot, continuous, tracking), MF (with AF 
override) / Multi-area or 1 (49 positions), 
face (re)detection / v (white)

AF (continuous, tracking) / multi-area or 1, face de-
tection / – (LED video and macro lamp only)

AF (continuous, tracking), MF / 9 or 1 (117 positions), face 
detection / v (orange)

Metering: Multi- / Center-weighted / Spot v / v / v v / – / v v / v / v
Programmed auto / Scene modes / Custom
Presets

v (EXR auto with scene recognition) / 17 / 1 v (with scene recognition) / 21 / – v (with shift and scene recognition) / 16 / v (3 memories)

Exposure: Aperture priority / Shutter priority /
Manual

v / v / v – / – / – v / v / v

Exposure compesation [EV] ±2 EV in 1/3 steps ±2 EV in 1/3 steps ±2 EV in 1/3 steps

Bracketing: Exposure / WB / Focus / v / – / – (film type, dynamic range bracketing) – / – / – v / v / –

Self-timer / Continuous shooting speed3 10 or 2 s or face recognition / approx. 8 fps, up to 32
shots

12 or 2 s / approx. 0.6 fps, 200 shots 10 or 2 s, 1 or 2 face or smile-controlled shutter release / 
2-10 fps, 10 shots

Interval mode / Sound / Comment function – / v (16-bit, stereo, 48 kHz) / 30 s – / v (AAC, mono) / 4 s – / v (16-bit, stereo, 48 kHz) / –
White balance: Auto / Presets / Manual v / 6 / v (with fine-tuning) v / 4 / – v / 7 / v (with fine-tuning)
Sharpness, Contrast, Saturation, Noise reduction
adjustable

v / v / v / v – / – / – / – v / v / v / v

Monitor: Size / Resolution (dots) / Protective
cover / Viewfinder

3.0" (vertically tiltable) / 460,000 / v / 
v (electronic, 200,000 dots)

3.0" / 920,000 / v / – 3.0" / 921,600 / v / v (electronic, 200,000 dots)

4-way selector / Multi selector / Command dials v (+ center button) / 1 / 1 v (Mini joystick) / – / – v (+ center button) / 1 / 1
Flash compensation / Recycle time5 / Connector ±2/3 EV in 1/3 steps / 5.6 s / v (TTL shoe) – / 4.3 s / –

(wireless flash control with Olympus system flashes)
±2 EV in 1/3 steps / 9.8 s / –

Playback
Multiple [# of images] / Zoom / Histogram 100, 9, 4 / v / v (also while shooting) 30 or 12 / v (up to 10x) / v (also while shooting) 25, 16 or calendar / v (stepless up to 8x) /

v (also while shooting)

Connectors / Dimensions
Power source 4 x AA, mains adapter Rechargeable Li-ion Mains adapter (proprietary), Li-ion rechargeable
Interfaces / A/V out / HDMI / Printer USB 2.0 / v / v (type C) / v (PictBridge) USB 2.0 / v / v (type D) / v (PictBridge) USB 2.0 / v / v (type C) / –
Diemensions (W/H/D) / approx. weight6 body,
ready to shoot5

131 mm x 91 mm x 126 mm / approx. 750 g 
(with 4 rechargeable NiMH batteries)

100 mm x 65 mm x 26 mm / approx. 225 g 122 mm x 87 mm x 93 mm / approx. 580 g

What’s in the Box
Manual / User guide Quick start guide, manual (PDF only) Quick start guide, manual (PDF only) Quick start guide (also in-camera), manual (PDF only)
Accessories 4 AA batteries, lens cap with strap, lens hood, 

wrist strap, USB and A/V cables
LI-50B Li-ion battery (3.7 V, 925 mAh), 
USB charger (battery charges in-camera), 
wrist strap, USB and A/V cables

NP-FH50 Li-ion battery (6.8 V, 870 mAh), wrist strap,
lens cap with strap, USB connection/charging cable,
USB charger (battery charges in-camera)

Optional accessories Mains adpater, rechargeable NiMH batteries and
charger, accessory flash unit, HDMI cable

Memory cards, mains adpater, battery charger, camera
bag, shoulder strap, HDMI cable, accessory flash unit,
underwater housing (to 40 m)

Memory cards, mains adpater, battery charger, camera bag,
HDMI cable

Software
Standalone software (platform) MyFinePixStudio 2.1 (Win), FinePix Viewer 3.6 (Mac),

RAW File Converter (Win/Mac)
ib (Win), Olympus Viewer 2 (Win/Mac) Picture Motion Browser 5.5 (Win)

Ratings
Test images1 (c’t test image shot in daylight)
Color rendition / Exposure + / ± + / ± + / +
Sharpness / Detail rendition ± / ± + / ± + / +
Image noise / Other artifacts2

- / - - / - - / +
HD video1 / Sound ± / + ± / ± ++ / ++
Ease of use / Printed manual + / - + / - ± / -
Feature set4 / included accessories 4 ++ / - ± / ± ++ / ±
RRP: Camera / Replacement battery (US$) 450 / – 319 / 28 400 / 20
1 judged by eye on a calibrated monitor 3 using largest native image size and best JPEG quality
(applies only to these cameras and therefore not comparable with earlier tests) 4 relative to similar class of camera

2 Sharpening and compression artifacts, noise, moirés, color fringing 5 measured values, recycle time for maximum flash power

++ˇexcellent +ˇgood ± satisfactory -ˇpoor --ˇinadequate vˇincluded –ˇnot included n/aˇnot applicable c
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Cyrill Harnischmacher

Build your own

Studio Gear
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If you are just starting out experimenting with studio
lighting and shooting techniques, expensive new gear can
quickly break the bank. But never fear – with the help of
easily available materials and a little manual skill you can
build studio accessories that are just as effective as high-
end pro equipment. This article shows you not only how
to go about building your own gear, but also how to use
it to get great photographic results.



Even if you move on to using professional
studio gear in the future, many of the DIY

accessories we introduce here will continue
to be part of your photographic life. To be
successful, tabletop photography often
requires spur-of-the-moment improvisation
and unusual technical solutions to everyday
photographic challenges. 

Building new tools is part of the routine in
pro photo studios too: reflectors have to be
tailored to a specific shot, light shapers need
to be modified, backgrounds are painted in
new colors and all sorts of ornaments are
produced seemingly out of thin air. This is
one of the skills all photographers have to
master, and homemade accessories are just
as much an investment in your photographic
future as expensive, commercially produced
equipment.

Is building your own gear really worth it?
My immediate answer is a resounding “Yes!” –
otherwise, I wouldn’t have taken the trouble to write this article or my
book on the subject. But, aside from any financial or commercial
considerations, getting to grips with light at this level is often a much
more rewarding experience than simply buying and using ready-made
tools.

You are sure to critically question the results of your DIY
experiments, and this naturally leads to a deeper learning experience.
Building your own gear also makes it possible to create tools that are
simply not available anywhere else, and it’s always easier to modify your
own equipment than it is to revamp things that you have bought. 

The following pages explain how to build a range of accessories that
will simplify your photographic life in the studio and out-of-doors.

Backgrounds

The main focus of any photo is of course the
subject. However, the background and the
objects surrounding the subject also play an
important role in the success of a shot. There
are many ways to make your own
backgrounds, and there are many everyday
objects that you can kidnap and use for
purposes they were never intended for. 

It is a good idea to build up a stock of
objects and accessories for inclusion in your
photos.  Hobby and model shops or DIY and
building supplies stores are great places to
start looking for wood surfaces, textured
paper, felt, fabric and much more besides. 

Wrapping paper made of unusual materials
or colored plastic is perfect for creating
interesting backgrounds, and a visit to a metal
workshop or a local stonemason can also reap
rewards. Odd pieces of exotic stone or

corrugated metal make ideal backgrounds for photographing jewelry.
Last but not least, a walk in the woods often yields a variety of source
of material. Fallen leaves, gnarled branches, delicate twigs, moss and
grass, shells, driftwood and pebbles all make wonderful makeshift
props.

Simple backgrounds are easily made by painting bold brushstrokes
onto card or canvas, and you can always use a spatula or a sponge to
vary the texture. Plaster of Paris is another versatile helper and can be
used to imitate stucco or concrete, and you can even make casts of
unusual objects in unmixed plaster powder. Impromptu rust can be
created by painting vinegar onto a piece of sheet metal and waiting for
a few days.
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There are many more examples of
great DIY studio equipment in Cyrill
Harnischmachers’ book Low Budget
Shooting, published by Rocky Nook

(www.rockynook.com).
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An old school atlas and
shallow depth of field
instantly make this tin airplane
look as if it is flying high
above Europe



Your own photos, printed on a large-format printer, also make
interesting backgrounds. With a little skill and the right lighting, you
can include blue skies, photogenic cloud formations, sunsets or
picturesque landscapes in your studio shots. And you are not restricted
to using props in the background. You can use reflective surfaces to
create the frame for your entire scene, like a mountain panorama
reflected in mirrored ski goggles, for example. 

Stage design stores sell specialist accessories such as transparent
acrylic cubes, artificial snow, water-effect sheeting, stage blood,
cobweb spray, fog machines and artificial turf. Once you start, you are
sure to end up with quite a collection of odds and ends that you need
to store somewhere and find easily when you need them. Don’t
underestimate the amount of space you will need, and try to keep
things tidy so that you can find what you need when you need it.
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Complex scenes can be effectively staged using simple props. 
The atmospheric background in this shot is actually a photo of a cloudy summer sky. 

You can find great backgrounds just about anywhere: here (from left to right) are corrugated card (stationery
store), rusty sheet metal and satin glass (builder’s supplies), flagstone (gardening store), punched aluminum
sheeting and ceramic tile (builder’s supplies) and various types of card (stationery store)



There’s no limit to
where you can
look for props
and supplies for
your home studio
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Unusual photo accessories and materials for building your own
props can be found just about anywhere. Flea markets are great
places for finding used eyeglasses, antique tools, cutlery,
crockery, aging wood and metal, and any number of other
unusual things that can give your photos extra punch and
pizzazz.

All of the materials that we used for the projects shown here are
easily available at shops and stores.

Builder’s Supplies: 
Tools, aluminum struts and brackets, shelf brackets, emergency
blanket

Kite Shops: 
Nylon string, fiberglass spars, connectors and other bits and pieces
for making things light but stable

Hobby Shops, Stationery Stores, Arts and Graphics Supplies: 
Foam rubber, spray glue, superglue, unusual paper, card, wrapping
paper, poster rails and gift boxes

Architectural Model Makers: 
An endless source of varied materials, including plexiglass, plastic,
metal sheeting, wire mesh, cardboard, plastic sheeting and special
tools

Advertising Media: 
Plexiglass, translucent diffusion foil

Photo Stores and Garage Sales: 
Markets and Internet auctions are a great place to look for photo
accessories with unusual thread sizes, adapters, filter gels, all sorts
of remote releases and flash brackets



A beanbag effectively
cushions camera vibrations
and adapts itself to the
shape of any surface

Beanbag Camera Supports

A simple beanbag is an effective way to absorb camera vibrations when
you are shooting at ground level or with your camera perched on a wall.
It also protects the bottom of the camera and the lens from damage
and helps you to level your shot. 

My 20 x 16cm (6 x 8-inch) beanbag is made of two pieces of leather
with dimensions that are slightly larger than the finished beanbag and
a thick zip fastener. You may need a special needle for your sewing
machine if you use particularly thick leather.

Fold the short side of the leather to make a hem and sew the zip to
the inner (rough) side of the leather. Now place the two pieces of
leather together with their smooth sides facing each other and sew the
remaining three sides together leaving about 1 cm of space at the
edges. 

You can now tie off the loose threads by hand, turn your finished
beanbag the right way out and fill it with dried beans, lentils or
styrofoam beads. As a finishing touch, you can impregnate the leather
with dubbin or shoe spray to make it weatherproof.

Do-it-yourself Photo Studio | Beanbag Supports
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I fill my beanbags with dried
beans. If you want to make a
lightweight version, you can use
styrofoam beads instead.
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Camera-mounted Spirit Level
If you need to make sure your camera is perfectly level, for
example, when you are shooting landscapes, a spirit level
attached to the camera’s flash shoe is a simple and effective aid. 

The one illustrated here was made by gluing a cheap level from a
do-it-yourself store to the bottom foot of an old flash bracket.
Before actually gluing the two parts together, use a second spirit
level to make sure that they are correctly oriented using a second
spirit level.

The disused foot of an old flash bracket is
fixed to the spirit level with superglue. The
finished unit is a great way to ensure your
camera remains level during shooting.

A simple builder’s spirit level used as a
camera leveling aid 

Plastic Bowl Light Tent

A light tent is the tool of choice for photographing objects with
potentially distracting reflective surfaces, such as cutlery or watches.
Just about everyone has a variety of light tents at home in the form of
translucent plastic bowls and storage containers. 

A simple bowl with a diameter of about 30 cm is ideal for shooting
macro photos. All you have to do is cut a hole with the same diameter
as your lens in the side of the bowl. The easiest way to do this is to draw
an outline using a felt pen and drill it out bit by bit. Any remaining joins
between holes are easily removed using a modeling knife. 

You can remove any remaining protrusions using a file and smooth
the edges of the hole using sandpaper. Light for your light tent is
provided by a flash unit. You can use holes cut in different places to
vary your camera angle. Such a modified bowl is also great for taking
outdoor macro shots at ground level.

Larger, rectangular plastic containers can be used too, although you
will need to glue a cardboard infinity cove into the container to smooth
the transition between the side and the bottom. Here too, light is
provided by one or more remotely controlled flash units.

Portable Infinity Cove
Infinity coves are used to make the transition between the vertical and
horizontal parts of a background invisible. If you don’t have a lot of
space for your home studio, an infinity cove that can be erected and
taken down in seconds makes it easy to organize a quick shoot on the
kitchen table or your desk. 

The basic components of a DIY infinity cove are fiberglass rods,
poster rails and thick card. The thickness of the card you use will depend
on the size of the cove you want to build. If you use a piece of 30 x 42cm
card, 300 g/m2 will be sufficient, but you will need thicker card for the
larger 50 x 70cm version – in this case, 1mm modeling card is ideal. 

We glued black velvet to one side of the card to give us a choice of
backgrounds. 

Make holes in the corners of the card using a normal hole punch.
The ends of the fiber glass rods are made from pieces of rubber tubing
and prevent the card from slipping off the rods. Wrapping a normal
rubber band around them achieves the same effect. Aluminum or
plastic poster rails fixed to the top and bottom edges of the card
provide extra stability. You can see the results in the photo of the blue
car opposite.



Our infinity cove is extremely portable and
quick to put up and take down

This photo, shot using our home-made infinity cove, shows just how 
the effective a smooth, horizon-free background can be

Fiberglass rods hold the cardboard infinity cove in
shape, while poster rails add stability
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Using a translucent plastic bowl
as a macro light tent. A lens-

sized hole in the side of the bowl
makes it possible to take

professional-looking photos of
reflective objects.

A photo of a watch taken in our plastic bowl light tent. The lateral light source produces a soft, subtle shadow.
Lighting subjects like this from both sides produces shadow-free results.
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Home-made light tents can help produce professional-looking results, 
like this product shot of an analog camera

Rectangular plastic containers
make great light tents too,
although you will usually need
to add a curved piece of card
to disguise the bottom edges
in the background. 



Reflectors
Reflectors control the direction of light, while diffusers scatter it to
produce softer shadows. Silver-colored diffusers produce clear
“technical” looking light, while gold-colored reflectors produce light
with a warmer character. White reflectors have a generally neutral
effect, while colored surfaces used as reflectors can be used to produce
a wide range of special effects and accents.

Mounting board from a graphic arts store is perfect for making
reflectors. It is usually matte black on one side and white on the other,
and has a foam core that makes it very light and easy to cut to size. This
makes it great for making small, custom reflectors that produce
highlights in metal, glass and other reflective objects. 

Not only does white styrofoam make a cheap, lightweight
alternative reflector, but its textured surface also diffuses light better
than smooth card. You can turn styrofoam black by gluing black card to

its surface or by painting it with water-based acrylic paint (available in
tubes from art suppliers). This type of paint dries quickly and doesn’t
dissolve styrofoam like solvent-based paint. 

Lightweight plywood panels are also a good base material for
reflectors. You can color them using emulsion paint or glue a foil rescue
blanket to the surface to make a gold-colored reflector. Crumpling the
blanket before fixing it to the plywood panel increases the diffusion
effect very effectively.

Metal shelf brackets of the type used to mount glass shelves in
bathrooms make ideal supports for home-made reflectors. They can be
adjusted to accommodate reflectors of different thicknesses using just
a single screw, so you don’t have to purchase a separate set of feet for
every reflector you use. They also make it quick and easy to switch
reflectors while you work.
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Photos shot using large reflectors display wonderfully soft transitions between areas of light and shade.
Here, we used this effect to turn simple pebbles into a beautiful sculpture.
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An absorber made of black
mounting board can be used to
produce shadow effects and
absorb stray light

The reverse of the same board
is white and makes a great
reflector for brightening
shadows

A reflector made from a sheet
of styrofoam and a rescue
blanket produces warm,
“sunny” light

This diffuser has a stable frame
covered with diffusion sheeting
from an advertising and
signage supplier. Diffusers
produce soft shadows and
uniform lighting effects.

The bottle in the photo on the left looks rather two-dimensional, but adding a white reflector to the setup helps to
brighten the shadows and produces a highlight on the surface of the glass, giving it more depth and definition

Bathroom shelf brackets make
perfect feet for reflectors and
diffusers
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In this photo, white reflectors
accentuate the dewdrops against the
black background



Holder for a Styrofoam Reflector
A flexible way to support a styrofoam reflector is to use a home-made
holder made from an aluminum bar and two carpenter’s nails. A
knurled-head screw with a standard tripod thread fixes the whole
assembly to your light stand. Simply drill a hole at each end of the
aluminum bar for the nails and a larger hole (usually 8 mm) for the fixing
screw in the center. The “prongs” of the holder are made from two
carpenter’s nails of about 10 cm (4 inches) in length that you can
hammer into the holes you have drilled. If the holes are too large to
hold the nails securely, you can use two-component glue to fix them in
place. For safety’s sake, it is better to file down the points of the nails. 

You can then fix your reflector holder to a light stand
or a tripod using the fixing screw and push your
styrofoam reflector onto the nails. And that’s all there
is to it!
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Diffusers

Building a diffuser is slightly more complicated than building a reflector
because you need to build a frame for mounting the translucent
diffusion foil. We used 8mm square-cut aluminum struts and triangular
aluminum angle brackets from a builder’s supplier and fixed them
together using a simple hand riveter. Once you have cut your aluminum
to length, use rubber cement to glue the components together to
ensure that everything fits. 

Now mark the location of the rivet holes on the angle brackets and
drill them using an appropriately sized drill bit. You can now use the
holes in the angle brackets to mark the struts for drilling. 

it is always a good idea to number the individual components of
your frame using a permanent marker so that you can assemble them

in the correct order. You may need to make a sketch of the parts too.
Once everything is in place, it is simple to use a hand riveter to finish
your frame.

Now all you have to do is fix a layer of diffusion foil (available from
advertising media suppliers) to your frame using transparent adhesive
tape. This type of foil produces diffuse, evenly distributed light. Here
too, the shelf brackets we described above make perfect supports.

A styrofoam reflector mounted on
a light stand with a tiltable head
makes a very flexible studio tool

Using blind rivets and a hand
riveter is a cheap and easy way

to fix the parts of a diffuser
frame together

Do-it-yourself Photo Studio | Diffusers

Triangular aluminum brackets and square-cut aluminum struts make
a simple, stable frame for mounting diffusion foil
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An aluminum bar and two
carpenter’s nails are all you
need to make an effective
reflector holder
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This is the pattern for making your own bounce
card. These measurements fit the Nikon SB-25 and
SB-26 Speedlights, but can easily be adapted to
fit other flashes.

A bounce card tilts with the
flash head and provides soft,
uniform light from above,
even when you are using
short focal length lenses and
short subject distances

Bounce Card for a Dedicated
On-camera Flash unit

This accessory is made using a piece of white card
cut using the pattern below. The measurements
we have used fit the Nikon SB-25 and SB-26
Speedlights, but it is simple to adjust the
dimensions to fit other flash units. Use the back of
a modeling knife blade to score the dotted lines
for easy folding. A wide rubber band is all you
need to fix the bounce card to your flash unit and
away you go! 

The bounce card increases the effective
surface area of the flash tube to provide softer
light, and tilting the flash head helps direct the
light at your subject. You can, of course, use other
materials with other colors to alter the character
of the light to suit your scene.
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The multi-flash mount is
particularly suitable for use
with softboxes or reflective
umbrellas

Our multi-flash mount is made from three flash shoes, an
aluminum plate, a knurled screw with inner and outer
threads and two 1/4-inch screws

This particular plate is designed to hold up to three flash
units

The flash units are fired using a remote cable and a three-
way adapter 



Multi-flash Mounting Plate

If your flash doesn’t have sufficient output for a particular project, you
can use a multi-flash mount to increase the flash power of a softbox or
reflective umbrella. The mount itself is just as simple to build as our
styrofoam reflector holder. All you need is three flash shoes with tripod
threads, two 1/4-inch screws and a 1/4-inch knurled knob with an inner
tripod thread. The base plate is made from a piece of aluminum (about
5 mm thick) that you can purchase at a
hardware store.

Saw the base plate to length (about 20
cm should do) and file the ends down to
make them smooth. Drill three 8mm holes
and countersink two of them (see the
illustration opposite). The distance
between the holes will depend on the size
of the flash units you are using. Screw the
individual components together, mount
your flash units, and you’re ready to go. 

Synchronizing your flashes is easiest if
they all have built-in infrared sensors that
fire when they detect the light from a main
flash. If this option isn’t available, you can
use a three-way adapter to connect the
flash units together and fire them using
either a single infrared or radio receiver or
a simple flash sync cable. Three-way flash
adapters are available from photo stores
everywhere.

Mirrors and Highlight Reflectors

Some subjects require extremely targeted lighting that you can
produce using mini-reflectors made from mirrors or small pieces of card
covered with reflective foil. Suitable silver and gold foil  can often be
found in the packaging for coffee powder or potato chips. 

You can cut mirror fragments to the correct size using a glass cutter,
but please be sure to wear gloves and protective goggles while you are

doing so to prevent injury from sharp
edges or flying shards. It is a good idea to
smooth the edges of cut glass using
sandpaper.

The simplest way to position small
reflectors is using foam rubber feet. Simply
cut a slot of the same width as your
reflector in a piece of foam rubber and
insert your mirror or card reflector. You can
then adjust the angle of reflection
precisely to fit your scene. You can also use
modeling clay as a base, or even a disused
gooseneck reading lamp.

You will often need a modeling light to
check the effects of your mirrors and
highlight reflectors in advance of shooting.
A normal clip spot positioned next to your
flash performs this task admirably.
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Highlight reflectors can be made from fragments of mirror, polished metal,
silver and gold foil or colored card 

Foam rubber stands allow you to
position your reflectors exactly the

way you want 



68 c’t Digital Photography 6 (2012)

Do-it-yourself Photo Studio | Mirrors

This attractive scene was created using hard lateral light and a collection of small
mirrors mounted on foam rubber stands



Light Brush
Pocket flashlights and LEDs make extremely flexible accent lights and
can also be used as a “light brush”. Traditional, incandescent light bulbs
produce a warm, sun-like light that is perfect for creating cozy moods.
In contrast, LEDs produce much “cooler” light. In the following section,
we’ll take a quick excursion into the world of LED lighting. Issue 1 (2010)
of c’t Digital Photography includes a workshop article on using LED
flashlights to make a tabletop studio in  (see also the link at the end of
this article).
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The main light here came from a flash, while the golden beam
lighting the coffee beans was produced by a pocket flashlight
with an incandescent bulb

❮❮❮❮



The “light brush“ technique requires the use of a tripod and
extremely long exposures during which the subject is expressively lit
using brush-like movements of a lamp. Combining such “brushstrokes”
with manually fired flash provides almost endless possibilities for
creating unique lighting moods. However, shots like this require careful
planning. Set a small aperture and a long shutter speed of several
seconds, and set white balance to “flash”. Flash gives a scene a neutrally
colored base light while incandescent torchlight provides an additional
warm, golden glow, as shown in the photo of the coffee beans on the
previous page (shot using a two-second exposure at f22).

To shoot this type of photo, set your flash to rear-curtain sync. This
causes the flash to fire just before the end of the exposure, providing
the scene with even, basic light. If you camera doesn’t support rear-
curtain sync, you can always fire your flash manually during the
exposure.
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There are all sorts of pocket-sized LED lamps
available at extremely reasonable prices

This type of lighting mood can only be produced using a
light brush. Typical exposure times for this type of shot are
between 10 and 20 seconds, during which the light from a

pocket flashlight is used to “paint” over the subject. 



Mobile Reflector/Diffuser for Outdoor Use

Some outdoor shots require the use of a light tent too: for example, to
reduce the harsh contrast often caused by bright sunlight. The basic
materials for this accessory are ripstop nylon, fiberglass rods and plastic
T-connectors, all available from kite shops.

Wrapping adhesive tape around the fiberglass rods while you are
sawing them to the right length helps to prevent them from splintering.
Make sure you use the thinnest possible rods, so that the finished light
tent isn’t under too much tension while it is in use. We used 2mm rods
in the one illustrated here.

The maximum size for such a light tent is limited only by the amount
of available material, and even a large version can be packed down to

a small size once you have removed the lateral frame rods. When you
are setting the light tent up, make sure the ends of the rods on one side
are firmly planted in the ground before you bend the assembly over to
form the final arched shape.

You can also use the light tent as a reflector or diffuser for larger
subjects by simply sticking the lower ends of the rods into the ground
and leaving the light tent standing up straight. Used with a remote
flash, it provides soft, natural lighting.
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The finished
light tent in
action

Our light tent is made from components available from any
kite shop and can be set up and dismantled in seconds

The same flash used with our mobile light tent produces uniform
light and a photo with a natural look and feel

Remote flash alone leaves some details insufficiently lit



Outdoor Reflectors and Diffusers
Reflectors and diffusers for outdoor use need to be light and
waterproof. Lengths of aluminum tube can be easily connected using
reinforced rubber tubing to form a stable frame. The diameter of the
aluminum tubes you use will depend on the size of the frame you want
to build. We used 6mm tubes for our 45 x 65cm  reflector. 

It is best to try out different diameters of tubing while you are in the
store to make sure you get a snug fit. Each corner piece needs to be
about 8 cm long. Make sure you file down the ends of the aluminum
tubes completely so that the tubing can slip over without catching.

We used white ripstop nylon from a kite shop for our reflective
surface. Once you have built your frame, lay it down on your chosen
fabric – the illustrations on the left show how to measure it and attach
it to the frame.

Once you have finished sewing the seams, you can slot the
aluminum rods into the resulting pockets and join the corners using
your pieces of tubing. If the fabric has any folds or wrinkles, you can
adjust the tension in the frame by moving the aluminum rods in or out
of the  corner pieces. Once you have finished your shoot, it is simple to
take the frame apart and stow it in a bag.
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Stick the fabric temporarily using adhesive tape and
mark the seams

Fix the seams using double-sided adhesive tape
before finally sewing them

Sew the edges together using a normal sewing
machine and white thread. The double-sided tape
prevents the seams from slipping out of position
while you are sewing.

Place the finished frame on the fabric and draw
around it. Allow about 1 cm extra along the edges 
for sewing around the aluminum tubes.

Our portable diffuser (or reflector, depending on the
material you use) is quick and easy to assemble. You can use
fabric leftovers to make a bag for the parts.



Ultra-light Reflector
This special reflector is designed for situations in which every gram
counts. Our 60 x 60cm version weighs just 80 g – in other words, less
than a bar of chocolate. 

The frame is made of 3mm fiberglass spars, which you can easily saw
to the right length. The corner connectors are nose connectors sold by
kite shops as part of the steering gear for stunt kites. The foil is actually
part of a rescue blanket taken from a first-aid kit.

The edge rods are 60cm long and the diagonal rods measure 82 cm.
These are necessary to keep the entire structure stable and also make
it easier to hold and position the assembled reflector. Once you have
put the frame together, you need to cut the foil to size, leaving a 3cm
overlap at each edge. Crumpling the foil before fixing it to the frame
enhances the diffusion effect it creates. Although the cross spars are
visible from one side, you can still use both sides of the reflector to
produce different effects. The silver side will produce cooler, more
“technical” light, while the gold side produces a warmer “sunlit” tone
that is particularly suitable for portrait shots. (jr)
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The gold side of our ultra-light reflector can even imitate
sunlight under a cloudy sky (shown on the right)

Constructing our ultra-light reflector. The frame
also acts as the template for cutting the rescue
blanket to size.

Fold over the edges and fix them using
transparent adhesive tape. No further gluing or
fixing is required. c

The finished two-color ultra-light reflector. The
visible framework on the reverse has no effect on
the results. 
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Bjoern K. Langlotz

Increasing depth of field with

Focus Stacking
In macro situations, even the smallest apertures often provide
insufficient depth of field to portray a subject adequately. The
solution to this problem is to shoot a sequence of images at varying
focal distances and use a computer to merge the results into a 
single, extended depth-of-field image. 
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Macro photographers often test the
limits of physics. The nearer you get to

your subject, the shallower the available
depth of field, and selecting ever smaller
apertures either begins to produce diffraction
blur or simply spoils the blurred background
that gives so many close-up photos their
character in the first place. 

It is relatively simple to counteract these
problems for stationary subjects. All you have
to do is shoot a sequence of images in which
you move the focal point successively further
into the distance from shot to shot. You can
then use one of a number of specialist
software packages to merge your source
images into a single image with a completely
sharp subject and a pleasantly blurred
background. This technique is called “focus
stacking”.

This article gives you the necessary
background knowledge and technical
know-how to shoot your own source images
for focus stacking, and  introduces the

software and techniques you need to produce
finished images. We also go into detail on how
to use Photoshop to stack tricky sets of source
images manually.

Depth of Field

The closer a photographic subject, the
shallower the available depth of field – an
effect that is particularly noticeable in close-
up and macro situations. Macro photographic
optics are subject to slightly different rules
than photography in general. At an aperture
of f8 and a reproduction ratio of 1:1, the
extent of the depth of field available for a full-
frame camera is just 0.89 mm, and the effects
of using different focal length lenses at this
kind of range are negligible. This effect is
often referred to as macro depth of field
compression. 

A further peculiarity of macro subject
distances is the way that depth of field
extends uniformly in front of and beyond the

plane of focus – an effect that is observable for
reproduction ratios of up to 1:10. Beyond that,
variations in focal length begin to have a
direct effect on the depth of field
characteristics of an image.

What all this means is that you will
generally have to use a small aperture to
produce sharp macro images. If the smallest
available aperture still doesn’t suffice, then
focus stacking is the solution. 

Shooting Source Images

It is extremely important that the subject
doesn’t move while you are shooting focus
stacking sequences, and it is also essential to
ensure that the camera only moves precisely
forward or backward along its optical axis,
especially if parts of the background are to be
visible in the finished image. If you don’t adhere
to these rules, you will end up producing
merged images with double edges and other
unwanted artifacts. A tripod is essential.
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The only way to capture this kind of
image, with the subject sharp from
head to wingtip in front of a
homogenous, out-of-focus
background, is by using focus
stacking techniques



Try to keep the increments in focal
distance constant between shots and make
sure that the fields of focus between shots
overlap slightly. It is also beneficial to the
overall process if all of your source images are
shot using the same exposure and white
balance settings, although some stacking
software is capable of compensating for slight
differences in brightness.

Focusing with the lens

The simplest way to change the position of
the focal plane is to rotate the focus ring on
the lens. In this case, the only accessory you
need is a tripod. The first step involves
focusing on what you think is the edge of
the zone that you wish to photograph in
focus. Pressing the depth of field preview
button helps you to judge the depth of focus
in your shot using the viewfinder, or you can
take a test shot and zoom into it on the
camera monitor to see if the results look
right. If your camera has live view
functionality, you can also use  a monitor
magnifier to help you judge depth of field
visually. This is especially useful if you are
shooting at a high reproduction ratio.

Once you have set everything up to your
satisfaction and have decided how much you
want to vary focus between each image in
your stack, you can vary focus simply by
rotating the focus ring slightly between shots 

This approach is simple, but involves some
risks. It is all too easy to inadvertently alter
your framing when you touch or adjust the
lens. Additionally, moving the focus ring in
identical increments doesn’ t necessarily shift
the plane of focus in identically-sized steps –
in fact, it moves exponentially further away
the greater the distance between the subject
and the focal plane. This means that you
actually have to shift the focus ring by
increasingly small amounts to shift the
position of the plane of focus consistently– a
task that is virtually impossible to perform
accurately.

Focusing using a focusing rail

A different way to shift the plane of focus is
to move the entire camera/lens assembly
back and forth. This is achieved using a piece
of equipment called a macro focusing rail
mounted between the camera and the tripod
head. You can then adjust the plane of 
focus in identical increments at a fixed
reproduction ratio. Because you don’t 
have to touch or adjust the lens, the risk of
accidentally adjusting your framing
disappears. If you use a focusing rail, make
sure that you frame your image for the

subject at its furthest focus distance before
you start to shoot a sequence. 

A focusing rail is a reliable method, but a
computer-controlled focusing rail, such as the
Cognisys StackShot, is even more accurate as
it automatically moves the camera between
shots and releases the shutter only when it is
precisely in position. The major disadvantage
of the StackShot is its price, which starts at
around US$500.

Focusing by Remote Control

Many contemporary cameras can be remotely
controlled using a computer. The technology
involved is often referred to as “tethered
capture” and allows you not only to view the
live view monitor image remotely on a
computer screen, but also to control various
camera functions, including the autofocus
motor. 

Macro Focus Stacking | Shooting Technique

The computer-
controlled StackShot
macro focusing rail
from Cognisys

A focusing rail like this one is not essential, but is a very useful piece of gear to have when
you are shooting macro focus stacking source images. A stable tripod is indispensable no
matter what other equipment you use.
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The Helicon Remote software package
makes full use of this feature. Once you have
attached your camera to your computer and
started the program, Helicon Remote
automatically activates the camera’s live view
mode. You can now set your exposure
parameters either directly on the camera or
remotely using the software. The combination

of the histogram and the preview window
makes it easier to judge exposure correctly. To
ensure that all photos in a sequence are shot
using exactly the same exposure values, it is
best to use manual metering mode. Use the
Advanced Settings panel to set flash control
to manual and pre-select a white balance
value if you are not shooting in RAW and don’t

plan to adjust WB settings and convert your
source images to TIFF before handing them
over to your focus stacking software. You also
have to define the nearest and furthest focus
distances using the arrow buttons (and
confirm them by clicking the A and B buttons)
before you can start to shoot a sequence. The
software then automatically calculates the
required number of shots. If you don’t trust
the program to set up the sequence correctly,
there is a built-in DOF calculator for checking
the settings it makes. Once you are satisfied
that the settings are correct, click the Start
Shooting button to get your sequence
underway. The software keeps you informed
of progress during shooting.

Lighting

In contrast to conventional macro situations
(see our Macro Photography article in Issue 4
of c’t Digital Photography), there are no hard
and fast rules for lighting a focus stacking
scene, and you can use ambient light, flash or
any other convenient light source. If you are
using a focusing rail and flash, mount your
flash independently from the camera so that
it doesn’t move and change the mood of the
lighting during the sequence. If you are using
reflectors to brighten your scene, these need
to be mounted separately too. Needless to
say, using your camera’s built-in flash unit is
taboo when you are shooting stacking
sequences.

Merging Your Source Images

You can merge your source images either
automatically using specialized programs
such as Helicon Focus, CombineZP or 
Zerene Stacker, or stack them manually using a
layers-capable image processing program like
Photoshop. In addition to these GUI-based
programs there are many command line
programs and other highly specialized
applications available (especially in the field
of microscopy) that do a similar job.
Photoshop, too, has included automatic
stacking functionality for several releases now.
All of the programs mentioned work on the
same basic principles, and the only real
differences are to be found in the ease of use
and the range of options available.

Both approaches have advantages and
disadvantages. In most cases, automatic
stacking works very well, but a manual
approach can be necessary if your source
images are too varied in quality for the
software to merge them automatically. 

The following sections describe how to go
about focus stacking using the programs
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The right-hand panel of the Helicon Remote window gives you an overview of the
camera parameters controlled by the program. The built-in depth-of-field (DOF)
calculator is shown in the center. 

TheCombineZP interface is clunky and
not particularly user-friendly. The
command line window accompanies
all actions and monitors progress
throughout.



mentioned above and describe the strengths
and weaknesses of the results they produce.
This issue’s free DVD includes our complete
stack of crystal source images for you to
experiment with, as well as the stacking
results we produced using CombineZP,
Helicon Focus and Zerene Stacker for you to
look at and compare.

CombineZP

Windows-based CombineZ has been around
for several years and is widely used. The
current version, CombineZP, is the only
freeware in our test group. It can be run in
Simple and Menu modes but both are
somewhat clunky and not very intuitive. The
Help pages open automatically with the
program, but don’t help very much either. The
interface is easiest to operate in Simple mode.

The first step is to import your source
images by clicking the New button. A window
then opens showing command line
instructions that follow the progress of the
import process. CombineZP supports JPEG, 
8-bit TIFF, BMP and PNG formats.

The Align and Balance used Frames
command in the toolbar’s drop-down menu
aligns the source images and makes any
necessary adjustments to their colors. Once
again, the command line window appears and
reports progress during the operation.

Once the source images have been
prepared, you can apply the Do Stack
command or one of the other stacking
variations found in the  drop-down menu. The
results we managed to produce using the
program’s automatic modes were acceptable,
but not as good as those produced by Helicon
Focus or Zerene Stacker. However, if you are
prepared to put in some work experimenting
with the manual settings, you can achieve
much better image quality.

The package now includes the Retouching
tool, which is located in the Stack menu. The
tool is not particularly well documented, but
has its own dialog that displays the various
settings you can make for the retouching
brush. These include copying and cloning
pixels from one source image to another.

Helicon Focus

Helicon Focus is one of the best-known and
most widely used focus stacking programs on

the market, and is available in 32 and 64-bit
versions for Windows and Mac. 

Click the + button in the program’s right-
hand Source Images pane to select and
import your stack. Make sure that your images

are loaded in the order in which they were
focused – otherwise the program might have
trouble merging them.

If necessary, you can change the order of
the imported images using drag-and-drop.
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Even the best results produced by Combine ZP‘s automatic stacking functionality are not as
good as those produced by the competition. Here, it produced obvious artifacts on the
crystal’s surface and the results were simply not sufficiently detailed.

You can arrange the order of your source
images manually in the Helicon Focus

Source Images pane. The settings found in
the Focus Parameters pane are used to

fine-tune the rendering process.



You can then click the Render button to merge
your stack. In many cases, the program’s
default settings produce excellent results, but
you might have to make some manual
adjustments for source images that are not

entirely homogenous. The Focus Parameters
panel offers two different rendering
algorithms. Method A weights each pixel
according to its microcontrast (basic
sharpness), whereas Method B selects the

source image that contains the sharpest pixel
and uses this information to create an overall
“depth map”. This method requires the source
images to be shot in consecutive order from
front to back or vice versa. Method B generally
produces very few halo artifacts around
important image details, and is the best option
in most situations. However, it still pays to try
out both methods and see which produces
better results for your particular stack.

The panel also includes sliders for
adjusting the Radius and Smoothing
parameters. Radius is the most important
rendering setting, and determines the size of
the area surrounding each pixel that is
assumed by the program to be sharp. Images
that contain multiple fine details (such as hair
or fur) generally require low Radius values
between 2 and 4.

The Smoothing slider determines how  the
focused parts of your images are combined.
Low values generally produce sharper results,
but tend to produce more artifacts in
transitions between areas of differing
sharpness. We found that setting Smoothing
to values of about half the Radius value
usually produced the kind of results we were
looking for.

The Autoadjustment preferences panel
includes sliders for fine-tuning the relative
positions and rotation  of the individual
source images during rendering. The Depth
Map Feathering setting defines the amount of
softening that is applied while merging
images. We recommend using a low value
that is greater than zero, which keeps the
transitions between images smooth without
producing too many obvious artifacts.The
default value of 3 is a good choice for most
standard situations.
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The Brightness slider is used 
in Retouching mode to
selectively correct the

brightness of  individual
image areas

The Clone tool is great for performing quick corrections to selected image areas. We used
it to adjust a small area to the right of the crystal that couldn’t be precisely identified in
any of the source images and therefore appeared unsharp in the rendered image.

The Helicon Focus Autoadjustment
preferences include various advanced
parameters, including fine-tuning for the
relative positions of the source images



Retouching with Helicon Focus

Every Helicon Focus rendering process
produces a range of different results that you
can select in the Output Images panel and
view and compare in the preview window. It is
very unusual for an automatically generated
image not to require any correction before
saving, and the program has built-in Clone
and Copy Source tools to help smooth out any
inconsistencies. The Clone tool woks in a
similar way to the Photoshop Clone Stamp and
is great for repairing image areas in which
none of the source images is sharp. The Copy
Source tool is used to copy source pixels from
source images into the rendered image.

The lighting changed slightly while we
were shooting our sample sequence, and the
effects of this change are clearly visible on the
crystal’s surface in the preview image.  The
software couldn’t quite compensate for the
differences in brightness, in spite of having
used the Weighted Average rendering
method. This is where the Copy Source tool
comes into play, as it enabled us to insert
appropriately bright  pixels into the relevant
source images. The absolute brightness of the
added pixels can be fine-tuned during the
process using the Brightness slider in the Tool
Properties panel.

Zerene Stacker

Zerene Stacker is not as well known as Helicon
Focus, but is available in 32 and 64-bit versions
for Windows, Mac and Linux. The  interface is
not quite as user-friendly as the one found in
Helicon Focus and the program is generally
slightly slower. It is capable of processing
JPEGs and 8-bit or 16-bit TIFF source images. 

Zerene Stacker offers two basic stacking
modes called PMax and DMap. The former is a
pyramid-based method that locates even the
finest details and is thus eminently suitable for
use with subjects that contain fine textures
(such as hair) or for merging images that
contain overlaps. The downside of this method
is that it produces more noise and contrast in
the rendered image and can cause unwanted
color shifts. The program does not offer any
additional fine-tuning options like those found
in Helicon Focus and sets all internal
parameters automatically on the basis of the
details it finds in the selected source images.

The DMap method is based on a depth
map and is best suited to merging soft
transitions and in situations in which you want
to preserve the original contrast and colors in
your images. This method is not quite as good
at detecting fine details as its counterpart.
DMap initially applies standard parameters
during stacking and offers a single slider

called Set contrast threshold for fine-tuning the
results.

A zero percentile threshold value leads to
halo effects at high-contrast edges, while a
value of 95 masks even correctly reproduced
areas in black. A medium value of 60
produced much better results for our sample
stack, and the software applies the selected
value only once you have confirmed it by
clicking OK.

Zerene Stacker has its own powerful copy
and clone tools for inserting pixels from

source images into your rendered results. It
also allows you to copy pixels from different
versions of a rendered image into the final
output version, which means you can
combine pixels produced by both rendering
methods to give you the best of both worlds. 

Photoshop CS5

It makes sense to save your source images to
a separate folder and to name them
sequentially so that the image with the closest
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Zerene Stacker‘s DMap rendering method includes a Threshold slider for adjusting the
merging parameters. A zero percentile setting produces halos at high-contrast edges, while a
setting of 95.0 masks even correctly reproduced image areas in black, as shown here.
Medium values of around 60 produce the best results.

The Photoshop Load Files into Stack script loads and aligns selected images into a new
image with a matching number of layers. You can then use the Auto-Blend Layers command
to create a focus-stacked image.



focus distance has the lowest number. Now
open the File > Scripts > Load Files into Stack
dialog and select the images you wish to
stack. Make sure you activate the Attempt to
Automatically Align Source Images option. This
is an effective tool and often saves a lot of
manual tweaking. A click on OK then creates a

new file that contains a separate layer for each
source image. 

The aim of the exercise is to merge the
sharp parts of each source image into a single,
completely sharp image. The quickest way to
do this in Photoshop is to select the layers you
wish to merge, open the Edit > Auto-Blend

Layers command, activate the Stack Images
and Seamless Tones and Colors options and
click OK. Photoshop then automatically creates
a new image with extended depth of field.
This is quick and easy, but the results are not
usually as clean as those produced by the
specialist programs mentioned earlier.
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This impressive image of a lizard
shows fantastic depth of field in the
foreground and a pleasantly blurred
background. It was merged from 78
separate source images, some of
which are reproduced opposite.

The non-aligned areas in badly aligned images show up
colored if you switch the layer you are viewing to Difference
blend mode

The sharpest areas can be roughly selected using the Lasso tool and
fine-tuned later using a layer mask



Manual stacking 
for tricky subjects

If your subject moves whiled you are shooting
a  sequence – as often happens with natural
subjects like the fly on a branch shown on the
left – the best thing to do is simply wait until
things have calmed down before you carry on
shooting. However, the following source
images rarely overlap perfectly with the ones
you shot earlier. Helicon Focus can
compensate for slight shifts between shots,
but this isn’t always sufficiently accurate. In
such cases, the best thing to do is to merge
your images manually using Photoshop. 

To check how well aligned the individual
layers are, hide all but two layers and switch
the blend mode for the upper one to
Difference. The lower of the two layers serves
as a reference and the upper layer will now
appear black except for the areas in which the
two images don’t precisely coincide. 

Now repeat this step for each successive
layer using the same reference image. Where
obvious shifts occur, select the layer
concerned using Ctrl+A and  move, scale,
distort or skew it using the Edit > Free
Transform tool until the layer appears as black
as possible. Confirm your changes with the
Return key. It is often simply impossible to
perfectly superimpose source images of
moving subjects, so try to concentrate your
efforts on merging the sharpest details rather
than the whole frame.

Selecting the sharpest details 

The next step involves selecting the sharpest
areas in each source image layer. Make an
initial, rough selection using the Lasso tool
with a feather setting of about 20 pixels and
create a new layer mask for the active
selection. You can then use the Brush tool to
fine-tune the masking in the blurred areas of
the image. 

Repeat these steps for every layer except
the one with the longest focal distance, which

serves as the background of the finished
stacked image. Once you are happy with your
results, you can flatten your image to a single
layer.

This method gives you the most control
over the individual steps in the stacking
process, which is often vital to producing
good results if your source images were
photographed under less than perfect
conditions.

Conclusions

Focus stacking is a powerful tool for working
around the limitations of photographic depth
of field and is a great way to produce images
of sharp subjects in front of pleasantly blurred
backgrounds. It is perfectly possible to shoot
source material for a stack without using any
special accessories at all, although, if you have
access to one, a focusing rail is a boon in most
situations.

Of all the stacking software we tested,
Zerene Stacker provided the best combination
of great results and user-friendliness. It isn’t
the fastest program we tested, but the results
require less tweaking, which saves time in the
long run. Helicon Focus is by far the fastest and
most intuitive to use among our test
candidates, and also offers the most individual
settings and processing options. With a little
practice and some retouching, Helicon Focus
produces results that are directly comparable
with those we achieved using Zerene Stacker.
CombineZP is free but works only on Windows
systems. It is not very intuitive to use and
produces only average results, making it less
interesting to experiment with. Photoshop CS5
produces only average quality stacks
automatically and offers its users no way to
intervene manually in the process.

If your source images contain framing or
color errors that automatic focus stacking
programs cannot handle, Photoshop (or any
other layers-capable program) can be used to
manually tweak and stack effective enhanced
depth-of-field images. (pen)  c
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Focus Stacking Software
Program Combine ZP 1.0 Helicon Focus Pro 5.1 Zerene Stacker 1.02 Photoshop CS5
Manufacturer Alan Hadley HeliconSoft Zerene Systems Adobe Systems
URL http://hadleyweb.pwp.

blueyonder.co.uk/
www.heliconsoft.com www.zerenesystems.com www.adobe.com

Plattforms Windows Windows, Mac OS Windows, Mac OS, Linux Windows, Mac OS
Benchmark1 4:56 min. 1:16 min. 2:46 min. 1:43 min.
Render quality ± + ++ ±

Retouching tools -
2

++ +
3

++

Handling -- ++ + ±

Price (approx. US$) free 200  (Lite version 30) 90  (Student version 40) 670 (Student verison 200)
1 Measured rendering a stack with fifteen 12-megapixel images (D3s) using a 2.8 GHz Core2Duo machine with 4 GB RAM 

running Mac OS X (Windows XP for CombineZP)
2 Ranking due to complex handling and poor results              3 Ranking due to limited toolset

++ˇexcllent +ˇgood ±ˇsatisfactory -ˇpoor --ˇinadequate







The shoot for this issue’s cover image has
become a multimedia project with a life of its
own. The original concept told the story of
two Victorian time travelers, and the “diary” in
which our heroes recorded their incredible
adventures in words and pictures is the
project’s first major by-product. This article
lets you in on some of the secrets surrounding
its creation and explains some of the
photographic and image processing  work
involved. 

The Location

The location had to fulfill all sorts of criteria 
if it were to be a convincing stage for a story
about time travel. Our protagonists had to
find themselves in the midst of scenery that
hinted at the past as well as the future. It was
obviously going to be impossible to create
this kind of nostalgic atmosphere in the
studio, no matter how much work we put in,
so we were on the lookout for historical
buildings right from the start. We took test
shots at a number of locations before aging
them artificially on a computer to find out
which would be best for our cover shoot.

The distance to the location and the
challenges involved in getting permission to
shoot were important factors in our
considerations, and we ended up using the
Landschaftspark Nord in Duisburg (a leisure
park built around industrial ruins)  and the
Zollverein coal mine in Essen. These
industrial monuments, with their enormous
old machines, seemed to us to belong to
some kind of parallel universe and made the
perfect backdrop for our visual ideas.

Design and Styling 

Our search for the right look for our planned
images led us inevitably to the steam punk
scene. This fantastic mix of retro and science
fiction has given rise to all sorts of sub-genres
and sub-sub-genres including music, clothing,
role-playing games and art. The basic physical
attributes of steam punk objects are a
Victorian look combined with contemporary
(or future) functionality.

We were very lucky to meet Alexander
Schlesier, who is an extremely skilled and
creative designer and set builder, and an
experienced creator of steam punk ephemera.
He agreed to kit out our time travelers with
their exclusive, bespoke equipment – the
portable time machine, the jewelry and many
of the other accessories are products of
Alexander’s workshop. Our stylist Susanne
Kutscher gave the costumes their wonderfully
authentic look. Our long-time friend, makeup
artist Birgt Kranzl, created the Elsa Lanchester-
esque look with big, silver-streaked hair, and
got our male time traveler looking like he had
just leapt out of the pages of a Jules Verne
novel. Photographer and project initiator
Thomas Saur took the photos using his
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The photographer’s sketches visua lized

some of the initial concepts for the look

of the shoot Alexander Schlesier helping to get our timetravelers’ costumes just right



beloved Hasselblad and presided over the
intricate post-processing of the images. He
was ably assisted by co-photographer Stefan
Arand, whose images also grace the pages of
many previous editions of c’t Digital
Photography. 

The Shoot 

The eight-person team bowled up on
location in the early morning with two
vanloads of equipment, much of which was
made up of the time travelers’ mysterious
gear. The magical surroundings, with their
heavy equipment and huge dials, levers,
valves and cog wheels definitely inspired
our models. Initially quite cautious, they
quickly got into the swing of things and
ended up on an investigative quest that had
them traipsing all over our enormous
“stage” with the six-person crew carrying all
the gear close behind. Countless views and
poses were captured for posterity using only
the ambient light and the light produced by
the machines themselves, which was quite a
challenge in some places. However, the long
exposure times fitted well into the old-world
atmosphere of the shoot, and the only
lighting aids we used to brghten the odd
shadow were reflectors made of cardboard,
foil and Styrofoam. 

Most of the photos you can see here were
shot using a medium-format digital camera,
resulting in a generally shallow depth of field
that contributed to the nostalgic look of the
finished images. The enormous range of detail
and tonal values that this format produces
gave us sufficient headroom for performing
the complex post-processing that the project
required.
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Photographer Thomas Saur 
and model Christian Fischer in action



The Portable Time Machine 

Alexander Schlesier explains: “The basic
framework of the machine came from a 1970s
wall lamp that I found in a scrap yard. I took it
apart and bent the copper plate straight
before sanding it down and ageing it
artificially. I then bolted an old brass porthole
from a flea market to the base plate and
added a firefighter’s pressure gauge and 
hose and parts of an old typewriter. The
centerpiece of the device is a small, battery-
operated plasma lamp that I fitted into the
porthole and covered with an old
optometrist’s iris diaphragm.“ 
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Alexander Schlesier was born in Plauen,
Germany in 1977 and is a qualified
advertising technician, designer and CAD
illustrator. He has always enjoyed taking
things apart to work out how they
function, and has built many weird and
wonderful machines over the years: “I was
building oddball devices like these long
before I had ever heard of steam punk.”

He now works as a designer in the
automobile industry and pursues various
projects in his free time. He tells us, ”The
steam punk genre fascinates me, and the
tinkering gives me the opportunity to
experiment and live out my ideas of
combining the old with the new. Life
today is fuller than ever of rules and
constraints and is increasingly
heteronomous, giving us too little time to
live out our fantasies. Steam punk is a kind
of pressure valve for me and embodies a
return to the materials and values of a
bygone time. This approach provides a

stark contrast to today’s mass production,
unbridled consumerism and the tendency
to accept things as they are. I try to use
old, authentic materials – such as brass,
copper, leather and steel – as much as
possible. I don’t particularly want to be
seen as an artist, and it is much more
important to me to keep my creativity
alive and to turn a few of my countless
ideas into reality. The photo shoot was a
lot of fun and a great experience – I can
certainly imagine taking part in other
projects like this should the opportunity
arise." 



Image quality 

Early photographers used large-format plate
cameras and uncoated lenses to produce
photos on metal or glass sheets coated with
light-sensitive chemicals. The technical
limitations of the time often produced heavy
vignetting and edge blur effects. To tone
down the high quality of our source images to
make them look authentic we used various
soft focus effects to degrade the image edges
and simulate the milky highlights often
produced by old lenses. We also used a
circular mask to simulate a classic vignetting
effect. 

Color shifts 

We processed the colors in Lightroom and
Photoshop to simulate the look of the
pioneering days of color photography at the
end of the 19th century. We wanted to
produce heavy color shifts, the yellowing that
characterizes old photos and the typical color
casts that result from the varying stability of

different colored dyes and pigments. In
some places we simply got creative and
used old, hand-colored Daguerrotypes as an
inspiration.

The documentary look 

We used scans and photos from old books
and letters, as well as old cardboard picture
frames and historical images to underscore
the documentary feel of the diary, either
superimposing them on our original photos
or using them to create alpha masks. 

Artificial  ageing 

Centuries of storage would have obviously
left their traces on the diary. For an even
more authentic look, we superimposed
scratches, moisture streaks and evidence of
mold or fungus on the images and added
artificial folds, tears and paper textures. The
result was a successful combination of our
fictional images with real patina, producing
a lifelike collage that we call The Time
Travelers’ Diary. (jr)
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Layer techniques were used to produce complex collages of photos, paper texture and ageing artifacts

How we Created the Diary’s Antique Look
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The Time Travelers’ Diary started life as a photo
shoot but, as we began to realize its potential,
quickly mutated into a complex multimedia project.
Our current plans include exhibitions, a book and a
spin-off film. For more details visit

www.timetravelersdiary.com
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Texture Blending | Workshop

The idea of adding textures to paintings and photographs is as old as these art forms
themselves. In a photographic context, the grain of black-and-white film was often
considered to improve the artistic look of an image, although grain itself is largely a
processing artifact. The same is true of oil paintings in which the paint and the canvas
add their own texture. Digital photos, too, can benefit from added texture. This
workshop demonstrates the diversity of texture blending techniques and gives you
some ideas for applying the technique to your own photos. The results are images that
often go well beyond simple photorealism.

Bettina Steinmueller, Uwe Steinmueller

Enhancing Your Photos
with Texture Blending



What actually is Texture Blending? The
idea is to combine main and texture

content to create a new, enhanced image.
Texture blending can result in subtle changes
that are hardly perceptible to the viewer or
major changes that give a photo a completely
different look. 

The result of blending a picture with one
or more textures is often more than just the
sum of the photos used. Texture blending is
always a process of exploration. In one
example, we use pebbles at the Pacific coast
and a photo of pale grass that was shot on its
own merit. Blending these images gives the
resulting photo an entirely new look and feel
(figure 1).

The Craft of Texture Blending 

Analog photographers often create blended
textures by making multiple exposures. 
This type of blending can be done by
sandwiching multiple negatives or using 
in-camera blending techniques. Today, the
digital blending process is easier to control
using Photoshop, or any other image
processing program that supports layers.
The following sections assume that you
already have a basic understanding of
working with layers.

Step 1: Adding a Texture as a Layer
Add the texture image as a new layer on top
of the main image. You can now apply various
strategies. Either resize the texture layer to

match the size of the original image (which is
how we work most of the time) or, if the
texture is larger than the original image, you
can retain its size and simply place the section
you plan to use on top of the main image. At
this point only the texture layer is visible
(figure 2). Simply lowering the opacity of this
layer often produces interesting results, but
Photoshop blending modes are a much more
powerful tool.

Step 2: Blending Your Images
Blending is done mainly using Photoshop’s
blending modes (figure 3). We apply the
blending mode in question to the top layer
of our stack, whether this is a single layer or
a merged combination of multiple lower
layers. Depending on the blending mode
you select, Photoshop calculates a new value
for each pixel in the image according to the
values present in the top and bottom layers.
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Figure 1: Texture blending produces results that are more than just the sum of the content
in the source images. This photo of pebbles at the Pacific coast has been given a completely
different look by adding the texture of grass.

Figure 3:
Photoshop offers

a wide range of
blending modes

for you to
experiment with

Figure 2: The
texture image
is placed on a
new layer



Normal is the default blending mode, and
uses just the pixel values in the top layer.

Photoshop’s blending modes are grouped
in sections, but not all of them are suitable for
creating texture blending effects:
• Normal/Dissolve: we don’t often use

Dissolve mode
• Modes that darken the image: Multiply is a

good candidate in this section
• Modes that lighten the image: Screen can

be used for some pastel effects
• Modes that darken and lighten the image:

See our description of the Overlay section
below for a basic understanding of these
modes

• The modes included in the last two sections
are not particularly useful for texture
blending applications

Not all blending modes suit our purposes. 
We very often use Overlay mode, and we 
have also used Multiply quite a lot in the past.
Soft Light and the other modes in the same
section offer some interesting variations to
experiment with. 

What does Overlay blending do? All pixels
within the texture that have tonal values
below 128 darken the resulting image – the
lower the value, the stronger the effect. All
pixels with values above 128 have the
opposite effect.

Step 3: Basic Blending Tuning
The upper image in figure 4 is by no means the
final image. Once again, a simple tweak
involves reducing the opacity of the texture
layer. However, we use a slightly different
technique. In this case, the highlights were a
little too bright for our taste, so we added a
Levels adjustment layer as a clipping mask.

A clipping mask layer only affects the next
layer down. If we hide the texture layer the
Levels layer would have no effect at all. The
effect here is as if we were to apply Levels to
the texture alone.

We use the Output Levels dialog to restrict
the tonal range to between 25 (the darkest
value) and 193 (the brightest value), thus
reducing the black and white levels in our
texture. Remember that we are currently
altering an Overlay blend, not a complete
image. 
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Figure 4a: Superimposing the
texture on the main image is just the
beginning. In the illustration below
we have added a Levels adjustment
layer as a clipping mask.

Figure 4b: Adjusting Output
Levels in the clipping mask



The texture not only changes the tonality
and detail of the blended image but also
blends in some of its own color. It is often
prudent to allow less of this color (in our case,
the faded yellow) to show in the result. To
achieve this, we also added a Hue/Saturation
clipping mask (figure 5).

Again, we use a clipping mask because we
only want to target the texture and not the
main image colors.

This is where things start to get more
complex. If we want to apply a blurred version
of a texture to get a softer look, we create a
blurred clipping mask copy of our texture
layer (figure 6).

Here, we adjust the strength of the blur
effect by adjusting the opacity of the blurred
layer (figure 7).

These are the main elements and
techniques we use for texture blending.
Remember, texture blending in not a
prescribed, mechanical process, and
experimentation is the key to interesting
results. We are always looking for ways to get
unusual results. A great approach is to try out
methods that your instincts tell you shouldn’t
really work.
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Figure 5: To prevent the texture
having an overbearing effect, an

additional Hue/Saturation clipping
mask can be used to reduce the

intensity of the texture’s own color

Figure 7: Here, you
can see the effect of

applying different
opacity values to the
blurred texture layer

Figure 8: The layer stack created by our
DOPF017_TextureBlending script

Figure 6: Using a
blurred version of 
the texture layer
gives the overall
image a softer look.
Here, we used a
strong Gaussian Blur
at 50% opacity.



The techniques we have described so far are just the basics, and
the only real limit to what you can achieve are the limits of your
imagination. We often blend more than one texture into an image
using a custom script that we wrote (if you use our script you need
to rename and collapse the upper layer group). Use masks to
selectively blend or tune the results, and experiment with layer
effects. These are just some of the techniques we use in the
examples described below.

It is important to keep an eye out for new textures. We create
and collect new textures all the time by photographing, collecting
from the web (while respecting copyright, of course) and blending
textures with other textures. Textures work best if they have high
resolution, and we have found 3,000 x 4,000 pixels to be a good
starting point for many of our projects, although there are situations
in which low-resolution textures work just fine. See the link at the
end of this article for an article we wrote about texture collecting
and resources.

Advanced Texture Blending

The layer group we often use for blending is slightly more complex
than the techniques described above. We create the group
automatically using our own DOPF017_TextureBlending script.
There is a free trial version of the script available for download that
only works for resolutions of up to 2,000 x 2,000 pixels, while the
full version costs US$25. 

Figure 8 shows the layer stack that the script creates with 
an additional blur layer added to the main image (created using 
our Texture Blending Tuning kit). There are also Levels and
Hue/Saturation layers for adjusting the base image the same way as
the texture image. Additionally, a global Levels layer allows us to
fine tune the complete image. The entire setup is organized in a
layer group that allows us to tune the overall blending effect and
apply layer masks to the group to blend selectively. Our Texture
Blending Tuning scripts also allow you to create texture blending
templates that allow you to treat multiple images in a more
consistent way (see also http://outbackphoto.com/CONTENT_
2007_01/section_workflow_basics_2011/20110203_Texture
BlendingTemplates/index.html). Our scripted layer group is a very
practical way to approach texture blending, but all of the examples
below can be reconstructed using standard image processing tools
too.

The Art Of Texture Blending

Some blended photos look like paintings. The important question
here is whether this really is the look we are trying to achieve. The
answer is “Probably not!”, and we take a very different approach to
that used by a painter creating a new picture. A painter starts with
a blank canvas that already has a texture of its own, whereas we
add textures later to increase the impact of “normal” photorealistic
images.

Essentially, what we are doing is all about enhancing the overall
mood of a photo, and we don’t mind if a “painterly” feel sometimes
results.

The following examples use original images, textures and
blended results to give you some tips and ideas about how to adjust
and enhance your own images using blending techniques. These
examples were all created using our DOPF017_TextureBlending
script but can just as well be recreated using standard Photoshop
tools or any other image processing program that has layer support.
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Too Clean

This image shows handrails that we photographed in 
Monterey. The photo has a simple, pleasing composition, but 
nevertheless looks a little too “clean“. 

The blended version of the photo has a more interesting mood
to it, although the effect an image has is always a matter of the 
viewer’s personal taste. We certainly like the blended image
more than the original! The apparent shadows in the new
version were created using this texture:

Textures can make interesting images in their own right, although
this photo of a dirty wall (shot expressly for use as a texture) is
not particularly interesting on its own. In this case, the main
photo and the accompanying texture were photographed on 
the same walk through Monterey.
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Abstraction

This time, we want to show you the final result first. We
particularly like the abstract nature of this image.

The original image is of compacted cardboard at a recycling
yard. We used the texture shown below to blend and then 
convert the original image to black-and-white.

The main photo and the texture were both taken with an 
iPhone. The texture photo was modified using the Hipstamatic
iPhone app.

Skies can be so Humdrum

It is difficult to take interesting photos of these beautiful oak
trees near our home because the sky framing them often looks
quite boring. The solution is, of course, texture blending.

The trees suddenly appear special in the blended version 
of the image. 

Here, the texture itself is the result of blending one of our 
own creations with a publicly available texture. We don’t even
know any more how many individual textures were involved, but
we can remember using paper, pebbles and an abstract texture
we found on the Internet. 
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An Etched Look

The look of this photo is a lot like that of an etching,
although this was not necessarily our intention when
we started work. The look was purely the result of our
experimentation during the blending process. The
original photo is a digital infrared photo taken using a
modified camera.

The nature of the texture we used may 
come as a surprise, as is often the case in a 

texture blending context.

It is, in fact, the surface of a metal fish
container photographed at the commercial
pier in Monterey.



Conclusions

We recently selected our top 10 images from
2010. To our surprise, it turned out that all of
them were texture blended to some degree.
Texture blending can be used to refine your
work or to create entirely new images. It is
interesting to note that some painters like to
create a photorealistic look in their work, we
photographers are now taking steps to make
our images look more painterly. In the end,

many photographers want to go beyond a
pure photorealistic copy of their subject and,
although this type of image abstraction and
enhancement doesn’t work with all types of
photographs (in a journalistic context, for 
example), in many cases texture blending can
add a unique mood to your photographs. We
think that texture blending is a technique
that is well worth exploring. 

References

Further reading on Texture Blending 
outbackphoto.com/tiny/TB1.html
outbackphoto.com/tiny/TB2.html
outbackphoto.com/tiny/TB3.html

Photoshop Scripts for Texture Blending
outbackphoto.com/tiny/filters.html (jr)  c

106 c’t Digital Photography 6 (2012)

Texture Blending | Examples

This Swallowtail butterfly has been captured in good detail, but
the background detail is distracting. In this case, we decided
against blending a texture with the original background and 
instead decided to isolate the subject first.

We blended the butterfly selection with one of our favorite 
textures to produce the following result.

We also used the mask we generated during the selection 
process to reduce the degree of blending for the butterfly itself.
Masking is a technique that can often be used to enhance 
blending work. 

Our selection is not perfect but, as you will see, it is certainly
good enough for blending.

The Tale of a Swallowtail





Alexander Altmann

Fantastic Photos with

Unusual Lenses
Most lenses are designed for ease of use and to
provide high-quality images in everyday use.
Alongside these “normal” lenses, there is a wide
range of unconventional and fun lenses available
for exploring offbeat photographic concepts. This
article delves into the wonderful world of shift
lenses, Lensbabys and fisheyes, and takes an
excursion into the outer reaches of pinhole and
plastic lens photography.
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Since the days when photographers had to
deal with heavy view cameras with huge
sheet film negatives, bellows focus and a cloth
for shading the focusing screen, technological
advances have made photography a lot
easier. But some old-school photographic
skills, such as adjusting the plane of focus,
have been lost along the way. It is possible to
move the plane of focus back and forth using

a wide aperture setting and a camera with a
full-frame or APS-C image sensor, but it still
remains parallel to the sensor plane. All the
objects that are located on the current plane
of focus are reproduced in focus whether you
want them to be or not. This behavior is self-
evident in the light of our habits and
expectations, but is neither essential nor
necessarily beneficial.

The plane of focus can tilted and/or
rotated at will using a view camera. This is
achieved by using the bellows to tilt the lens
plane in relation to the film plane. Macro
bellows (for example, from Novoflex) are the
only accessory available for conventional
cameras that have built-in bellows. All other
types of lens are firmly attached to the camera
body, which makes them cheaper to produce
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The Canon TS-E 45mm f/2.8 can be rotated
on its mount, but cannot be tilted and
shifted in opposite directions

Tilt/Shift Lenses

Photographers have very different 
demands when it comes to accessory

lenses. Beyond the standard kit zoom or
normal lens delivered with the camera,
experience and personal taste mean that the
next lens you buy can be anything from a
super-telephoto to an ultra-wide-angle. Many
photographers choose macro lenses as their
second fiddles, as these also make very
effective portrait lenses. 

Further down the line, most photographers
start to play around with unusual compositions
and there are enormous numbers of
unconventional lenses out there that are
perfect for taking off into the realms of
experimental photography. Extreme wide-
angle views, selective focus and a nostalgic
look are just some of the possibilities. If you feel

inspired to follow the pinhole photography
path of the earliest photo pioneers, there are
accessories available for you, too. Or maybe
you feel like tilting the plane of focus to attract
your viewer’s attention to a particular detail?
All this and more is possible in the digital age,
and the use of unusual lenses is experiencing
a serious renaissance.

A quick look at what’s on offer from lens
and accessory manufacturers reveals a broad
selection of more or less exotic lenses, ranging
from tilt/shift and fisheye to variable-bokeh
portrait lenses. Our search also led us to
unorthodox creations such as the Lensbaby,
the Diana+ and the Toy Lens, as well as a
whole range of simple screw-on lenses and
pinholes. This article shows just what you can
do with some of these oddball optics.

Shifting involves moving the optical axis of
the lens perpendicular to the sensor plane.
Architectural photographers often use this
functionality to prevent the occurrence of
converging lines in their images. If you tilt
your camera upward while photographing
the front of a building, you will be able to
capture the entire façade in one shot, but
the vertical lines contained in it will
converge. If, however, you align the sensor
plane of your camera parallel to the
building’s front, you will no longer capture
converging lines, but you will also no
longer be able to capture the full vertical
extent of the building. Shifting the lens
vertically upward includes more of the
upper parts of the building in the shot but,

because the sensor remains parallel to the
building, there will notbe any converging
lines in the resulting image.

If you photograph a row of houses from
diagonally in front using a wide aperture,
only a small portion of the façade will
remain in focus. To ensure that the entire
row remains sharp you will either have to
stop the aperture right down or tilt the lens
until the plane of focus is parallel to the
fronts of the houses. Shift functionality can
nowadays be simulated digitally, but
requires the use of a short focal length lens
and plenty of extra space around the
subject to allow for subsequent distortion
and cropping. 

Tilt and Shift



and more stable, and is also conditional on the
mechanical limitations of a 35mm camera
body with its shallow flange focal depth (i.e.,
the distance between the lens throat and the
sensor plane). 

High-end lens manufacturers still sell
special-purpose tilt/shift lenses for use in
architectural and other specialized situations.
They are complex, expensive and fairly tricky
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These three images were all shot at a
constant aperture but using different tilt

settings. In the uppermost (non-tilted)
image, the plane of focus is aligned with the

advancing pawn. We tilted the lens toward
the chessboard in the center image, which
positions the plane of focus parallel to the

board at the level of the heads of all the
pawns. In this case, the board itself is 
out of focus. The lower image shows

the effect of tilting the lens upward – the
plane of focus is now almost vertical. 

Canon EOS 5D Mark ll, 
TS-E 45mm lens at f2.8

A Nikkor 24mm f/2.8 AI lens
mounted on a Sony NEX-5 using a
Tilt Transformer. The crop factor
of the APS-C sensors gives the
lens an equivalent focal length of
about 35mm. 
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to operate, which is why their effects are
seldom seen in everyday photos. This is a
shame because the effect is not only
impressive, but can also be used to draw the
viewer’s attention to specific image details.

Canon and Nikon manufacture tilt/shift
lenses with various focal lengths ranging from
17 to 90 mm (see the table on page 126). The
least expensive Canon tilt/shift model is the
TS-E 45mm f/2.8 for about US$1,300. The best
value offering from Nikon is the PC-E 85mm
f/2.8D Micro Nikkor at about US$1,700. If you
want to experiment with longer focal lengths,
you will have to use a medium-format shift
adapter, as described below. 

Medium-format Shift Adapters

In order to prevent vignetting when they are
shifted or tilted, tilt/shift lenses project a much
larger image circle than conventional lenses. A
good value alternative to purchasing a
specialized lens is to use a third-party tilt
adapter. The only prerequisite is that your lens
was manufactured for use with a camera with
a larger sensor format than the one you want
to adapt it for – i.e., the diameter of its image
circle is greater than the width of the image
sensor. This means that we can adapt 35mm
or full-frame lenses for use with APS-C
cameras.

The Ukrainian company Arax Foto
(araxfoto.com) manufactures a tilt adapter for
mounting lenses with Pentacon Six, Practisix
and Kiev 60/88 mounts on most DSLRs. The
adapter has a maximum of eight degrees of
tilt and costs US$125 plus US$27 for delivery.
Arax Foto also sells suitable medium-format
lenses, and there are many bargains to be had
on the second-hand market if you shop
around. Usable 80mm (medium-format
standard) lenses can be found for US$100 or
less.

Tilt lenses allow you to position the 
plane of focus exactly where you want. 
In this photo, it runs from the left-hand 
foreground to the door in the 
background, and is almost vertical.

Sony NEX-5, Lensbaby Tilt Transformer 
with a 35mm f/2 Nikkor set to f2.8



Tiltable Lenses for 
Mirrorless Cameras

The Lensbaby Tilt Transformer, which is
available bundled with the Lensbaby
Composer for US$350, is designed for
mounting and tilting Nikon lenses on Micro
Four Thirds or Sony NEX cameras. The
mechanics of the unit are based on the fact
that the flange focal depth of these cameras
is significantly shallower than that of most
DSLRs. Nikon lenses used with the Tilt
Transformer also allow the use of 
semi-automatic aperture control. Even
though the newer G-series lenses don’t
actually have an aperture ring, the aperture is
set the same way as it was 50 years ago using
a small lever in the bayonet mount. When

rotated, the Tilt Transformer moves the lever,
although there is no precision involved, so the
results are non-reproducible. Older lenses
with built-in aperture rings are the better
alternative if you have access to them.

We can thoroughly recommend the Tilt
Transformer for creative photographers who
owns Nikon lenses and are considering
buying (or already own) a mirrorless,
interchangeable lens camera. The Sony NEX-3
currently costs about US$350 and the
Olympus PEN-EPL1 about US$400 (both prices
for the body only). If you already own a DSLR,
an Arax adapter with a used medium-format
lens is probably a less expensive way to go. 
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A tilt lens can be used to focus exclusively
on a person’s eyes while leaving all the
other details in a portrait out of focus. 

In this example, the upper image was shot
without tilt, while the lower one was shot
using tilt to shift the plane of focus so that
it was positioned on a plane that joins the
two figures. This makes it obvious that they
are looking at each other.

Canon EOS 5D Mark II, Carl Zeiss Jena
Biometar 80mm f/2.8 and an Arax adapter,
½ second at f2.8
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A Canon EOS 550D/Rebel T2i fitted with an
Arax adapter and an 80mm medium-format
lens. The lens can be tilted by up to eight
degrees and rotated in any direction. 



A few years ago, US photographer Craig
Strong felt that his lenses were stifling his
creativity, so he built his own and called it the
Lensbaby. The first ever Lensbaby was a
simple glass lens attached to a flexible
bellows that could be bent, stretched and
compressed in any direction. The
movements of the bellows determined the
plane of focus and the “sweet spot” at which
focus was (fairly) sharp. “Fairly” because the
non-coated glass lens that Strong used not
only produced the now well-known
Lensbaby asymmetry and image curvature,
but also prismatic color shifts and a
significant degree of blur. Long exposures
weren’t possible with the first Lensbaby
because it sprung back to its original position
the moment you let go of it.

Lensbabys rapidly gained popularity and
there are now four basic models to choose
from called Muse, Composer, Control Freak

and Scout. They cost US$150-400 and the
basic difference between them is the way in
which focus is set and fixed. The Muse is freely
movable, while the Control Freak has three
threaded adjustment screws and a locking
mechanism for making precise settings. The
Composer’s entire lens assembly is mounted
on a ball and socket mount that makes it quick
and easy to perform smooth selective
focusing, and a locking ring allows you to hold
the position you have found during long
exposures, or while you shoot a sequence of
identically composed shots. The scout model
cannot be tilted, and is configured as a fisheye
in its base version. 

All Lensbabys have swappable front
elements and the company’s own Optic Swap
system offers a range of alternative optics
including plastic and (coated or non-coated)
glass lenses, as well as pinhole/zone plate,
fisheye and soft focus models. 

There is also a range of Lensbaby
accessories, including +4 and +10-diopter
macro lenses, a 1.6x telephoto attachment,
and 0.6x and 0.42x wide and ultra-wide-angle
attachments that transform a standard lens
into a 30mm or 21mm (equivalent) lens.
Remember to allow for the crop factor if you
use Lensbabys with an APS-C or Four Thirds
camera. All Lensbabys are available with
Canon, Nikon, Pentax, Sony and Four Thirds
mounts.

A typical Lensbaby image.
The  sweet spot is located on the tram
and the other details are blurred. Images
like this are strongly reminiscnet of
macro photos of miniature models. 

Canon EOS 550D/Rebel T2i, Lensbaby
Composer, 1/60s at f2.0

Lensbabys
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Typical Lensbaby blur creates a feeling of movement, which we
combined with some real motion blur on the part of our “ghost” 

Canon EOS 5D Mark II, Lensbaby Composer, 
1/80s at f2.0

The Lensbaby Composer kit includes aperture
disks ranging from f/2.8 to f/22 and a
magnetic storage box that doubles as an
inserter/remover tool. The default maximum
aperture (without a disk) is f/2.0.
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Lensbaby How-to

Although Lensbabys are tiltable they are not
“true” tilt lenses. The simple optical
construction makes it impossible to keep the
entire field of view in focus. The lenses do not
have a plane of focus, but instead a single
point called the “ sweet spot” at which the
subject is in focus. The size of the  sweet spot
is determined by the size of the aperture,
which is in turn adjusted using replaceable
metal disks with holes of different sizes cut in
the center. The aperture disk is held in place
magnetically and is easy to swap using the
special tool included with the kit. The system
is slightly complicated but has the advantage
that the circles of confusion produced by the
lens are always perfectly circular (or oval), not
pentagonal, hexagonal or septagonal like the
ones produced by most SLR lenses.

In order to portray an object in sharp focus,
you not only have to make the right distance
setting, but also adjust the  sweet spot to
coincide with the subject. This makes focusing
something of a challenge: we recommend

that you align the  sweet spot first, before you
focus using the manual focusing ring. It is
sometimes necessary to realign the sweet
spot once you have set focus, especially if you
are using a wide aperture. Getting it right
requires a tripod and some patience. If your
camera has live view, using it magnified
makes life a lot easier. With some practice and
a relatively flexible definition of “sharp”, you
will soon be able to get great results, even
shooting handheld. 

Alongside exposure and framing, the
Lensbaby sweet spot provides an additional
compositional element to play with. It takes
some practice to get used to using it but, once
you have mastered its idiosyncrasies, you will
find that the effect can enhance many types
of image, including portraits. 

Lensbaby also sells the multi-function
Lensbaby Composer with Tilt Transformer kit
for Micro Four Thirds and Sony NEX cameras.
This version is fully compatible with the optic
Swap system and has a slightly brighter
maximum aperture of f1.6. The lens costs
US$350.

It makes a difference whether you use a Lensbaby on a full-frame or
a small-sensor camera. Much of the characteristic edge blur lies
outside the crop camera’s image frame. 

Canon EOS 5D Mark II, Lensbaby Composer, 
1/60s at f4.0

Lensbabys are perfect for focusing the
viewer’s attention on a particular detail 

Canon EOS 5D Mark II, Lensbaby Composer,
1/30s at f2.0



Effective images have a tangible effect on the
viewer, whether they remind us of the past,
draw our attention to a new aspect of the
present, or present familiar objects in an
unusual way. The scratches on those old
photos of Dad looking young or Mom playing
with the kids on the beach are what makes
them authentic, and the yellowed look of old
color snaps makes it obvious that the scenes
they portray took place a long time ago. The
feel of the paper, the often odd-looking colors,
the grain, the vignettes and even the blur all
contribute to the mood of a vintage image. 

Nowadays, even though all of these effects
can be reproduced using the “retro” buttons
in an image processing program or functions
built into a camera’s firmware, many
photographers still prefer to take the
supposedly more authentic route of using
special lenses, filters and other accessories to
produce unusual or old-school visual effects. If
it’s a slightly blurred, low-contrast look you’re
after with a few color fringes thrown in for
good measure, then look no further than the
next plastic lens. These are usually made
completely of plastic, from the bayonet to the
optical elements, and are available as part of a
disposable camera, built into the legendary
Lomo or as interchangeable lenses for plastic
medium-format cameras.

This section reviews three plastic lenses
built for use with the Diana+, a cheap
medium-format analog film camera made of

plastic. Complete Diana+ cameras are
available for as little as US$50 from
www.lomography.com. Diana cameras have
just two shutter settings, called Normal (N),
which is equivalent to about 1/60s, and Bulb
(B), which keeps the shutter open for as long
as the shutter button is pressed. However,
used with an appropriate adapter, Diana+
lenses can be mounted on modern DSLR
cameras and can thus take advantage of all
the flexible exposure options these offer.

If you use Diana+ lenses with a crop-sensor
or full-frame camera, then only the center of
the image circle will be recorded,
automatically doing away with the vignetting
and edge blur that characterize Diana images.
When used with the medium-format Diana+
camera, the 38mm Diana lens has an ultra-
wide angle of view, while the 20mm lens
produces circular fisheye effects. Used with a
full-frame DSLR, the 38mm produces
medium-wide-angle effects, while the 20mm
lens produces images with straight lines that

are distorted but otherwise pretty
unspectacular. We found that the effects
produced by the 20mm lens and a crop-
sensor camera were simply dull. 

Diana+ lenses cost US$40-50 plus US$15
for a Nikon or Canon adapter. The price is
acceptable as long as you don’t equate value
with optical quality! We recommend that you
glue the adapter to the lens, otherwise the
loose fit can cause it to simply fall off while
you are focusing. 

These lenses have no aperture setting of
their own (aperture settings are made in the
camera body), and have an equivalent
aperture of about f9.5 when used with a DSLR,
making them unsuitable for low-light use or if
you want to use aperture settings to affect the
depth of field in your images. The light meters
in some low and mid-range Nikon DSLRs don’t
work with manual lenses, so if this is the case,
you will have to follow the classic
“Lomographic” principle of “guess the
exposure and shoot”. 

The accessory specialist
enjoyyourcamera.com sells 26mm f/1.4 and
35mm f/1.7 plastic lenses for Micro Four Thirds
cameras under the SLR Magic Toy Lens brand.
These both have steplessly adjustable
apertures and focus and, once we had played
around with the settings for a while, produced
results similar to those we achieved with the
Lomo lenses. The typical optical
characteristics of these lenses are a sharp
central area with shallow depth of field at full
aperture (similar to the Lensbaby sweet spot)
and interesting bokeh and vignetting effects
at the edges of the frame.

The Monochrom Subjektiv is named after
the opposite of “Objektiv”, which is also the
German for “lens”. The Subjektiv consists of a
set a set of five lens inserts (glass, acrylic,
Fresnel zone plate, pinhole and variable
aperture), providing you with a wide range of
experimental configurations and settings. This
lens costs about US$280, is available with
various mounts and is extremely well made
(www.monochrom.com).
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Other plastic lenses:

The lens on the left is
the Monochrom
Subjektiv. The other
two are Micro Four
Thirds models from
SLR Magic.

Diana+ 55mm, 38mm and 20mm fisheye
lenses fitted with Canon adpaters 

Plastic Lenses
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The upper image was shot using a 38mm Diana+ lens and
shows significant blur and inauthentic colors – in this case,
the vignettes were added later.
The lower photo was shot using a Canon EF 24-105mm f/4
lens. Here, we adjusted the colors digitally to make them
more like the ones produced by the Diana+ lens. 

Top: Shot using a 38mm Diana+ lens mounted on a Canon EOS
5D Mark II. The focus and highlight effects were all produced
by the lens and were not otherwise processed or altered. 
Bottom: The same scene photographed using a “proper” lens. 
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A portrait lens must have an appropriate focal
length and a decent maximum aperture, but
most importantly it must be capable of
reproducing differentiated skin tones. Overall
image definition shouldn’t be too sharp and
bokeh should be as smooth and unobtrusive
as possible. Normally, lens designers have to
choose between emphasizing the quality of
background or foreground bokeh and, once
the decision has been made, the results are
permanently built into the lens. This is,
however, not the case for Nikon’s 105mm and
135mm AF DC Nikkor lenses. Introduced in
the early 1990s, these are still the only models

available that allow the photographer to
directly influence the characteristics of the
bokeh they produce. 

It is generally accepted that highlights that
become darker toward their edges produce
more pleasing bokeh effects. The opposite
effect is grating and can spoil a photo
completely. Lens designers control bokeh
effects by adjusting the corrections made for
spherical aberration in the lens elements. In
principle, spherical aberrations are sharpness
errors, and they cause a lack of microcontrast
and consequent softness in the resulting
images. Spherical aberrations are usually

corrected as much as possible in quality lenses
which are designed to produce maximum
sharpness. Deliberate “under-correction” is
often used to reduce absolute sharpness and
produce pleasant background bokeh. 

Nikon engineer Kouichi Ohshita explained
that the DC (Defocusing Control) mechanism
only became possible once rear-focusing (RF)
technology had been perfected. The front
group of elements in the 105mm lens remains
completely stationary during focusing, while
slight movements of one of the elements in
this group cause changes in spherical
aberration without producing additional
chromatic aberrations or other significant lens
errors. With the DC ring at its zero setting,
spherical aberration within the lens is almost
completely corrected and the results are
extremely sharp. Rotating the DC ring in the
“R” (Rear) direction causes under-correction of
spherical aberration and produces better
background bokeh. Shifting the ring in the
opposite “F” (Front) direction produces over-
corrected spherical aberration and better
foreground bokeh. The DC ring has markings
up to 5.6 in both directions, but can be rotated
beyond these. If the DC setting is larger than
the current aperture, the lens produces an
overall soft focus effect. 
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Nikon Portrait Lenses

Well-defined but not overbearing sharpness combined with a soft transition to the blur of
the background – the effects produced by the AF DC Nikkor 105mm f/2.0D are specially
tailored to the demands of high-end portrait photography.
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Two Nikon portrait legends:
On the left is the 1971 AI-S Nikkor 105mm

f/2.5, with its 5 elements in 4 groups design.
On the right is the 1993 AF DC Nikkor 105mm

f/2.0D – bigger, heavier, brighter 
and even better than its predecessor. 



Handling

The defocusing effect is controlled by
selecting an F or R setting that is the same as
the currently selected aperture setting. You
can only focus after making the DC setting, as
this also affects focus, making the numbers on
the focus scale slightly inaccurate. This is why
it is possible to focus this lens “beyond
infinity”.

Both lenses also produce excellent results
without use of the DC functionality. Both have
relatively simple designs (6 elements in 6
groups for the 105 mm, compared with 7/6 in
the 135mm) and are therefore not prone to
significant diffraction effects. Additionally, the
front element in the 105mm version is quite
deeply recessed, making it possible to shoot
almost directly into the light without
producing too many unwanted reflections.
The rear focus system makes for fast
autofocusing, but only with Nikon cameras
that have an AF motor built into the camera
body. The minimum focus distance for the
105mm model is 90 cm, which doesn’t equate
to true macro scale but does allow you to
shoot portraits from very close up. 

The AF-S VR Micro-Nikkor 
105mm f/2.8G ED-IF can focus at closer
distances and is known for its sharp, high-
contrast reproduction characteristics, but
doesn’t reproduce skin tones as well. One
comment that we found on the Web
expressed the opinion that the Micro-Nikkor
was designed by a scientist, whereas the
DC-Nikkor was obviously designed by an
artist.
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Three portraits shot using the AF DC Nikkor 
105mm f/2.0D mounted on a Canon EOS 5D
Mark II. The two upper images were shot at

f2.8 with defocusing settings of R2.8 and
F2.8 respectively. The uppermost image

displays the best bokeh (see the red
hanging ornament on the far left). The

lower image was shot at f2 with the DC ring
set to beyond R5.6. The result is a nice

overall soft focus effect that is more subtle
at less extreme settings. 



Fisheyes certainly belong “unusual lenses”
category. The ultra-wide angle of view and the
extreme barrel distortion they produce make
photos shot using fisheyes immediately
identifiable. As with other unusual lenses, the
effect can quickly become tiresome if it is used
too often or in inappropriate situations.
However, if used carefully, fisheye effects can
help to create fascinating images. Using a
fisheye is the only way to capture a 180-degree
field of view in a single photo. 

In fact, fisheye lenses are constructed
much like the human eye, and it is only thanks
to the excellent “real-time distortion
correction” performed by our brains that we
don’t see the world with a fisheye perspective. 

A fisheye lens projects an image with
accurate proportions but distorts all the
angles and straight lines that don’t pass
through the horizontal center of the frame.
The further straight lines are located from the
center of the frame, the more distorted they
appear in the final image. In principle, fisheye
lenses are simply uncorrected lenses with
large angles of view. In contrast, ultra-wide-
angle lenses are heavily corrected in order to
render straight lines and angles accurately
and in a natural-looking way. Lens corrections
of this type falsify the proportions within the
image, and the further an object is located
from the center of the frame, the larger and
more distorted it will appear.

Thanks to their simple construction,
fisheye lenses are less prone to diffraction and
reflection effects than ultra-wide-angles, and
they do not suffer from unwanted vignetting,
making them eminently suitable for
astronomical, meteorological and town
planning applications.

Fisheye lenses have a larger angle of view
than equivalent ultra-wide-angle lenses of the
same focal length. The shortest focal length
full-frame ultra-wide-angle lens that we know
of is the Nikkor 13mm f/5.6 AI-S, constructed
with 16 elements in 12 groups and an angle
of view of “only” 118 degrees compared to the
180 degrees covered by the current 16mm
f/2.8 Nikkor fisheye. The fisheye has 8
elements in 5 groups and is four times as
bright as its 13mm cousin. 

Types of Fisheye Lens

There are two basic types of fisheye lens that
differ in the type of projection they produce.
Early, 8mm circular fisheye lenses don’t
illuminate the entire rectangular film frame,
but instead produce a circular image with a
diameter that is equal to the 24mm height of
the frame (a 7.5mm fisheye produces an
image circle that is only 23mm in diameter).
They have vertical and horizontal angles of
view of 180 degrees so, if you lie on the

ground on your back and shoot upward, you
will produce a semi-spherical panorama that
includes the sky and the entire surroundings
from just above the ground and upward. 

Nikon was by far the most adventurous
manufacturer of fisheye lenses in the period
from the 1960s to the 1980s. Their most
famous creation was the 6mm f/2.8 Fish eye
Nikkor with a retrofocus design that obviated
the need to lock up the mirror to mount the
lens on a camera. This monster weighs 10½
pounds and has a front element with a
diameter of 22 cm and its own built-in tripod
mount. The extraordinary angle of view of 220
degrees means that this lens can actually “see
behind itself”. 

The effect of circular fisheyes quickly
became passé and the images they produce
are difficult to display effectively alongside
“normal” images, so the next logical step was
the development of full frame fisheyes. These
lenses project an image circle that is 43 mm in
diameter and have a diagonal angle of view of
180 degrees. This design results in 15 or
16mm focal lengths and produces images
that completely fill a 35mm frame without
vignetting effects at the corners.

Lens manufacturers have now begun to
produce full-frame fisheye lenses that fit
cameras with smaller image sensors. The
sensor “crop factor” of 1.5 or 1.6x results in
lenses with 10 mm focal lengths.
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The Sigma 10mm f/2.8 EX DC HSM is a full-frame
fisheye lens with a 180-degree angle of view

designed for use with crop-sensor cameras. On
the left, you can see the slip-on front element

protector with its removable lens cap.

Fisheye Lenses
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Uses for Fisheye Lenses 

Thanks to their large angles of view, fisheye
lenses are ideal for capturing maximum detail
in cramped spaces. The typical fisheye barrel
distortion is less obvious if you position your
camera parallel to the floor and aim it at a
detail that is located midway between the
floor and the ceiling. When using this type of
lens, even the smallest changes in camera
position have a marked effect on the look of
the resulting image. 

If you use a fisheye to shoot a landscape,
make sure that the horizon runs precisely
through the vertical center of the frame and
that there are no objects that contain
straight lines located toward the edges. If
you adhere to these guidelines, you can
capture sweeping landscapes that do not
include any obvious fisheye effect. However,
if you deliberately position the horizon
slightly above the center of the frame, you
can produce an effect that visualizes the
curvature of the Earth. This particular effect
is most convincing if you shoot from a
slightly raised viewpoint and keep the angle
of tilt of your camera subtle.

Fisheyes also make great “special effects”
lenses. Their typical distortion, extreme
depth of field and stretched perspective
effects are perfect for accentuating the
effects of spatial depth or narrowness. It
takes some practice to find subjects that
work well with fisheye effects, but half the
fun is experimenting and finding out just
how strange and wonderful things can look
if photographed this way.

Software-based 
Distortion Correction

The PanoTools software suite – developed
by  Helmut Dersch, a professor of
mathematics and physics – forms the basis
of a number of cheap and free software
packages and plug-ins that are designed 
for correcting the barrel distortion in 
fisheye photos and converting them 
to pseudo-ultra-wide-angle views. 
PTLens (www.epaperpress.com/ptlens), for
example, is available for Mac and Windows
as a standalone program or as a Photoshop
plug-in. The trial version of the software
allows you to process 10 images and the full
version costs US$25. The program is capable
of correcting pincushion and barrel
distortion, vignetting, chromatic aberration
and perspective for a wide range of lenses.
The Hugin package, a free alternative
program with similar functionality, is also
avalable for Linux and FreeBSD.
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Fisheye lenses are great for shooting in restricted spaces 

Canon EOS 550D/Rebel T2i, Sigma 10mm f/2.8 fisheye, 1/40s at f5.6
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The original image is shown at the top, and the “corrected” version (made using PTLens),
with its ultra-wide-angle look is shown beneath. The “stretched” car on the far left shows
how dramatic the effects of lens correction can be. Correcting fisheye photos this way results
in the loss of the parts of the image that lie above or below the white horizontal lines. 

Canon EOS 550D/Rebel T2i, Sigma 10mm f/2.8 fisheye, 1/320s at f8.0



Any investigation into the roots of
photography sooner or later leads to the
pinhole camera – the simplest of all optical
systems. A pinhole camera consists of a
lightproof box with a tiny hole in its front and
a light-sensitive plate or film inside the back.
Any DSLR or EVIL camera can be used as a
pinhole camera by attaching a suitable “tiny
hole“ in front of the sensor. Many people use
a lens cap with a hole drilled in the middle as
a makeshift pinhole attachment, although
drilling the hole correctly isn’t quite as easy as
it might sound. 

In order to produce a halfway decent
image with an acceptable degree of focus, the
pinhole has to be extremely small, precisely
circular and cleanly drilled without rough
edges. It is easier to drill such a hole in metal
than in plastic, so the simplest solution is to
insert a drilled metal disk into a lens cap. The
models available at www.ramaidea.it are a
good example of this approach (for details,
see the table at the end of this article). 

The size of the hole depends on the
distance between the hole itself and the
sensor, and ranges between 0.1 and 0.3
millimeters for most DSLRs. Larger holes
reduce the exposure time but create blur that
can make the subject almost unrecognizable.
Theoretically, smaller holes create sharper
images but, in practice, increase the incidence
of refraction, which then negates any
potential increases in sharpness. If you know
the diameter of your pinhole and the distance
to the sensor (i.e., the flange focal distance),
you can calculate the effective aperture of
your pinhole as follows: 
Aperture = Sensor Distance/Pinhole Diameter.

For Canon EOS cameras with their 44mm
flange focal distance, a 0.25mm pinhole
equates to an effective aperture of f176. This is
about six f-stops darker than the normal
minimum SLR aperture of f22, and thus
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Pinhole
Attachments

The uppermost image was taken using a
standard lens. In the center pinhole photo,

the details disappear into a soft blur,
making the image even more “flowery”.

The lower image shows just how prone to
backlight artifacts a pinhole can be – shot

without shading the lens, the photo displays
severe color smears that cover

the entire image area.



requires you to use an exposure time that is 
26 = 64 times as long as you require at f22.

If you want to take pinhole photos in low
light or using lower ISO values, you will
definitely need to use a tripod to keep the
camera still during the resulting exposures,

which can be as much as several minutes
long. The viewfinder image is extremely dark
at an effective aperture of f176, so the best
way to adjust your framing is to take a test
shot and zero in on the optimum settings
from there.

Pinholes do not produce fringing or
distortion effects, but don’t allow you to alter
the depth of field in your image by changing

the aperture. They are equally sharp (or, more
accurately, unsharp) from the close
foreground right up to infinity, so it is a good
idea to choose a photogenic background to
experiment against. 
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Fun Lens Overview
Manufacturer, URL Available Through Product Type System1 Street Price (US$)
Tilt/Shift
Canon, www.canon.com Retail channels TS-E 17mm f/4 Tilt/shift lens C-EF 2,350
Canon, www.canon.com Retail channels TS-E 24mm f/3.5 Tilt/shift lens C-EF 2,100
Canon, www.canon.com Retail channels TS-E 45mm f/2.8 Tilt/shift lens C-EF 1,300
Canon, www.canon.com Retail channels TS-E 90mm f/2.8 Tilt/shift lens C-EF 1,300
Nikon, www.nikon.com Retail channels PC-E 24mm f/3.5 Tilt/shift lens Ni 1,979
Nikon, www.nikon.com Retail channels PC-E 45mm f/2.8 Tilt/shift lens Ni 1,899
Nikon, www.nikon.com Retail channels PC-E 85mm f/2.8 Tilt/shift lens Ni 1,829
Tilt
Lensbaby, www.lensbaby.com store.lensbaby.com Lensbaby Muse (50mm f/2) Tilt lens with “sweet spot“ C-EF, Ni, Ol-E, Pe-K, S-AF 150
Lensbaby, www.lensbaby.com store.lensbaby.com Lensbaby Composer (50mm f/2) Tilt lens with “sweet spot“ C-EF, Ni, Ol-E, Pe-K, S-AF 250
Lensbaby, www.lensbaby.com store.lensbaby.com Lensbaby Control Freak (50mm f/2) Tilt lens with “sweet spot“ C-EF, Ni, Ol-E, Pe-K, S-AF 350
Tilt Adapters
Arax Foto www.araxfoto.com Tilt adapter Tilt adapter for medium-format lenses All 35mm/full-frame systems 125
Lensbaby, www.lensbaby.com store.lensbaby.com Tilt Transformer Tilt adapter for Nikon lenses MFT, Sony NEX 230
Lensbaby, www.lensbaby.com store.lensbaby.com Composer with Tilt Transformer Tilt lens with “sweet spot“ for Micro Four Thirds

and built-in Nikon lens adapter
MFT, Sony NEX 350

Lomo
Lomography,
www.lomography.com

http://shop.lomography.com Diana+ 20mm Fisheye Medium-format plastic lens 
(Pentacon Six bayonet)

C-EF, Ni (with Adapter) 49
(plus 17 for an adapter)

Lomography,
www.lomography.com

http://shop.lomography.com Diana+ 38mm Medium-format plastic lens 
(Pentacon Six bayonet)

C-EF, Ni (with Adapter) 42 
(plus 17 for an adapter)

Lomography,
www.lomography.com

http://shop.lomography.com Diana+ 55mm with macro 
attachment

Medium-format plastic lens 
(Pentacon Six bayonet)

C-EF, Ni (with Adapter) 55 
(plus 17 for an adapter)

Portrait Lenses
Nikon, www.nikon.com Retail channels AF DC Nikkor 105mm f/2.0D Portrait lens with defocusing and bokeh control Ni 1069
Nikon, www.nikon.com Retail channels AF DC Nikkor 135mm f/2.0D Portrait lens with defocusing and bokeh control Ni 1390
Fisheye Lenses
Canon, www.canon.com Retail channels EF 8-15mm f/4L Fisheye Circular/diagonal full-frame fisheye zoom C-EF 1499
Nikon, www.nikon.com Retail channels AF DX Fisheye Nikkor 10.5mm

f/2.8G ED
Diagonal fisheye for DX format cameras Ni 775

Nikon, www.nikon.com Retail channels Fisheye AF Nikkor 16mm f/2.8D Diagonal fisheye for FX (full-frame) cameras Ni 900
Sigma, www.sigmaphoto.com Retail channels 10mm f/2.8 EX DC HSM Fisheye Diagonal fisheye with ultrasonic AF C-EF, Ni, Pe-K, Sigma AF, S-AF 649
Tokina, www.tokinalens.com Retail channels AT-X 10-17mm f/3.5-4.5 AF DX

Fisheye Zoom
Diagonal/full-frame fisheye zoom 
(180/170-100 degree angle of view)

C-EF, Ni, Pe-K, Sigma AF, S-AF 599

Lensbaby, www.lensbaby.com store.lensbaby.com Lensbaby Fisheye Optic 12mm Fisheye for the Lensbaby Optic Swap system, 
160-degree angle of view

Lensbaby Composer & Scout,
others with adapter

150

Pinholes
Ra.Ma. www.ramaidea.it Rising Pinhole Lens 0.22 mm pinhole diameter, approx. aperture f/216 C-EF, Ni, S-AF, Ol-E, Samsung

NX
40

Others
SLR Magic enjoyyourcamera.com Toy Lens 26mm f/1.4 Multicoated glass lens with sharp center area MFT 99
SLR Magic enjoyyourcamera.com 35 mm f/1.7 Multicoated glass lens with sharp center area MFT, S-Nex 140
Monochrom www.monochrom.com Subjektiv High-end kit with five optical inserts C-EF, Ni, OL-E, S-AF 280
1 C-EF = Canon EF, MFT = Micro Four Thirds, Ni = Nikon, Ol-E = Olympus E, Pe-K = Pentax K, S-AF = Minolta/Sony AF, S-Nex = Sony NEX

The illustration on the left shows a home-
made pinhole attachment, while the one on
the right shows the thin metal pinhole
insert of one that was professionally drilled.
This approach makes it possible to produce
smaller, more precisely dimensioned
pinholes.
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The effective focal length of a pinhole
attachment is equal to the flange focal
distance of your camera plus the thickness of
the lens cap or attachment you are using,
which usually equates to about 50 mm. This
means that you can use extension rings to
increase the focal length. The same pinhole
attachment has an effective focal length of
between 75 and 100 mm when used with
small-sensor cameras with a crop factor of
between 1.5 and 2. 

Pinhole photography fans have their own
global festival (www.pinholeday.org), which
they celebrate every year on the last Sunday in
April. Anyone who is interested is invited to
make pinhole photos on the day in question
and upload the results to the festival site. (pen)
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Evenly distributed blur that stretches 
from the foreground to the background 

is typical of a pinhole photo c



Dmitri Popov

The digiKam All-in-one Open Source

Photo Workflow Tool
Similar to GIMP, digiKam is a free open source package but, while GIMP is a pure
image editing application, digiKam excels at managing and processing photos too.
In fact, the two applications complement each other, so you can use digiKam to
keep tabs on your photo collection and do some basic photo tweaking and leave
the job of advanced photo retouching to GIMP. Now that we’ve sorted that out,
let’s whet your appetite with a closer look at some of digiKam’s key features.

digiKam | Photo Management 
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While commercial tools like Adobe
Lightroom and Nikon Capture NX2

are popular choices among serious
amateurs and professional photographers
alike, they are not the only fish in the sea.
And before you splash out serious money
on high-end software, you might want to
consider lesser known yet powerful
alternatives like digiKam. While this open
source application reigns supreme on the
Linux platform, it still remains relatively
unknown among Windows and Mac OS X
users – primarily because there was, until
recently, no easy way to install and run
digiKam on these platforms. However, the
digiKam developers made the latest beta
version of digiKam available as a Windows
installer, which makes it significantly easier
to give digiKam a try.

Feature Highlights

❏ Thanks to the LibRaw RAW decoding and
processing library (www.libraw.org),
digiKam can handle a wide range of RAW
formats, including the usual suspects like
NEF, CRW, CR2, RAF and DNG. digiKam
currently supports 427 cameras that shoot
in RAW, and new models are added almost
as soon as they hit the market. Quick tip:
You can view a list of all supported
cameras by choosing the Help >
Supported RAW Cameras menu item.

❏ digiKam offers several ways to view your
photos. You can use a conventional album
view, browse photos by tags or by date, or
display your photos as a timeline. You can
also view your photos on a map, provided
they have been properly geotagged.

❏ The application sports a separate interface
for working with geodata, which you can
use it not only to geotag photos, but also
to geocorrelate them. digiKam offers
another useful feature called Reverse
Geocoding, which allows you to retrieve
human-readable data such as city, street
and country names based on a photo’s
geographical coordinates. This data can
then be stored in the form of new tags, so
you can easily search for photos taken in a
specific country, city or street.

❏ The photo management interface provides a
wide array of tools to help you to keep tabs
on your photos. As with any photo
management program that is worth its salt,
digiKam offers tagging and rating features,
as well as Color labels and Picks tools. The
former lets you apply color codes to photos,
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The Configure interface lets you tweak a wide range of settings. You can configure the way digiKam handles RAW files and metadata,
enable and disable Kipi plugins, switch between different database back ends and much more besides.

digiKam | Features 
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while the latter can come in handy for rating
and prioritizing your photos.

❏ digiKam includes powerful filtering and
search capabilities. The dedicated Filters
sidebar in digiKam’s main interface offers a
simple yet flexible way to filter photos using
nested, user-defined criteria. For example,
you can set up a filter that displays photos
that contain specific tags and color labels,
and that have a rating of three or more stars.

❏ The application supports non-destructive
editing and versioning. This allows you to
tweak photos to your heart’s content
without affecting the original image data.
In addition, you can save multiple modified
versions of a single original and use
digiKam to organize them as well as keep
track of changes made to each version.

❏ When it comes to editing, digiKam offers a
smorgasbord of useful tools. As well as the
standard Curve and Level adjustment
tools, the package boasts exposure
blending, lens correction, perspective
adjustment, black-and-white conversion
and many other nifty features. Better yet,
the application sports powerful batch
processing capabilities that allow you to
apply multiple editing and conversion
operations to sets of photos.

❏ Thanks to a comprehensive collection of
bundled plug-ins, you can publish your

photos using many popular photo sharing
services without leaving the photo
management interface. Flickr, Picasa,
Facebook and SmugMug are just a few of
the supported services.

Weaknesses

It’s not all good news, though, and digiKam
does have several weak spots. Let’s start by
taking a look at the limitations of digiKam for
Windows. 

When you plug a camera into a Linux
machine, you can access it directly and pull
photos from it from within digiKam. This
feature doesn’t yet work on Windows, so you
have to use the Windows import tool to move
photos from the camera to your computer
and then add them to the digiKam library. 

The Trash feature doesn’t work either, but
you can work around this issue by deleting
photos instead of sending them to the trash.
To be fair, these issues are not caused by
digiKam itself, but are due to bugs in the
underlying KDE libraries that the application
relies on. The digiKam interface is also an
acquired taste. It lacks the polish of
commercial applications, and the sheer
amount of available features and tools can be
overwhelming. To make matters worse, there
is no proper documentation, and while it is

not particularly difficult to figure out how to
use the application’s basic features, getting to
grips with some of the advanced functions
requires a fair amount of effort.

Installation

Running the installer tool guides you
through the installation process, but before
you can fire up the program, there are a few
additional things that you need to do first.
Although the version of the installer used for
this article adds entries to the Start menu,
they all point to the wrong locations. To fix
this issue, you need to point each item to 
the correct executable file. For example, 
to fix the digiKam entry, right-click on 
it in the Start menu, choose Properties, 
and replace the existing C:\Program
Files\digiKam\kde4\bin\digikam.exe path
with C:\Program Files\digiKam\KDE4-MSVC\
bin\digikam.exe. Repeat this step for other
digiKam-related entries in the Start menu.

The program includes the nifty Exposure
Blend feature that allows you to merge several
photos with different exposures into a single
image with improved dynamic range. To make
this feature work in digiKam, you need to
install two additional packages. First,
download and install the Hugin application
(http://hugin.sourceforge.net/download/),

digiKam is capable of assigning multiple tags and sub-tags to photos, and even supports custom keyboard shortcuts 
for frequently used tags 
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then copy the align_image_stack.exe
executable from C:\Program Files\Hugin\bin\
to C:\Program Files\digiKam\KDE4-MSVC\bin\.
Grab the latest version of the Enblend
package, extract the enfuse.exe executable
from the downloaded zip archive and move it
to C:\Program Files\digiKam\KDE4-MSVC\bin\.
Once you’ve done all the preparatory work,
launch digiKam and follow the instructions in
the setup wizard to configure the basic
settings.

Configuration

Although you can start using digiKam right
away, it’s worth spending a few minutes
tweaking the default settings located under
Settings > Configure digiKam. By default,
digiKam uses the SQLite database to store all
key information and metadata, although it
does support a remote MySQL database too.
Using MySQL as digiKam’s back-end allows
you to access your photo collections from
multiple digiKam installations – for example,
on your notebook and desktop machines. Of
course, this approach requires a MySQL server,
and you need to set up two dedicated
databases for your metadata and your
thumbnails. Hooking the program up to the
MySQL back-end is easy: in the Configure

window, switch to the Database section, select
MySQL from the Type drop-down list and
specify the required connection information.

Next, you should add so-called collections
(i.e., folders) where you store (or plan to store)
your photos. digiKam supports collections
stored on local drives, removable media or a
network share. To add collections, switch to
the Collections section, press the Add
Collection button next to the appropriate
collection type, and select the desired folder.

digiKam can write metadata directly to
photos, or you can configure it to save each
photo’s metadata in a separate XMP sidecar.
Storing metadata this way has several
advantages. It is significantly faster than
saving metadata to image files and also allows
you to store metadata for RAW files without
writing it directly to RAW, which can be
problematic. To enable the XMP sidecar
functionality, choose Settings > Configure
digiKam, switch to the Metadata section and
select the desired option from the Metadata
Writing Mode drop-down list. You can choose
between Write the XMP sidecar only and Write
to image and XMP sidecar options. Enable the
Read Metadata from XMP sidecar files option
and press OK to save your settings.

digiKam sports two separate interfaces for
organizing and processing photos. The main
interface is designed for asset management

and provides access to the organizing,
viewing and search tools. To put all the
features at your fingertips, the main interface
has two sidebars and a main working area,
where currently selected images or albums
are displayed. The left-hand sidebar is used to
switch between different view modes, such as
Albums, Tags, Timeline, Map Searches, etc.
The album view is the default, and displays a
hierarchical tree of existing albums. Selecting
an album displays its contents in the main
window. The right-hand panel can used to
view and edit a photo’s histogram and access
previous image versions. The Filters sidebar
lets you specify filters for displaying photos
that match specific criteria.

Populating collections with photos is a
pretty straightforward procedure. In the
Albums view, select the collection you want
and choose Import > Add Images to import
individual photos or Import > Add Folder to
import a complete folder. Once you’ve
imported photos, you can tag them to
simplify image management. digiKam lets you
create and assign an unlimited number of tags
and sub-tags to create a highly granular view.
For example, you can create a “macro“ tag and
then add “tamron90mm“ and “nikon105mm“
sub-tags for shots taken using specific lenses.
You can also assign keyboard shortcuts to
speed up the tagging process – simply right-
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The Geolocation interface
makes geotagging your
photos simple. The Search
sidebar can be used to
quickly find the desired
location on the map, while
the GPS Correlator section
lets you geotag photos 
using a GPX file.
Additionally, the Reverse
Geocoding sidebar provides
tools for transforming
geodata into human-
readable location data.
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click a tag in the Captions/Tags sidebar (on the
right) and choose Properties. Press the
Shortcut button and hit the key combination
of your choice to register the shortcut and
click OK to save it. You can now apply the
shortcut directly to selected images using
your chosen keystroke.

Color labels is another feature that can come
in handy for keeping track of your photos. As
the name suggests, it allows you to color code
photos using one of nine color labels. Each color
label has a keyboard shortcut assigned to it,
which speeds up the process of applying them.
How you use this feature depends on the way
you structure your workflow – for example, you
can apply one color label to photos you share
on the web and a different one to photos you
plan to use in your portfolio.

The Image > Geolocation command opens
the program’s dedicated geodata interface,
which offers several ways to obtain the
geographical coordinates of the place where a
photo was taken. You can use the mouse to
locate the desired spot on a map or, if you know
the full or partial address of the location, you
can use the built-in search feature to find it

automatically. Click on the Search tab, enter the
address in the search field, hit the Search button
and you should see a list of matching results
with corresponding pins on the map. The
easiest way to add geographical coordinates to
photos is to drag them from the list to the
desired spot on the map. Alternatively, you can
assign the geographical coordinates of a
specific search result by making a selection from
the image list, right-clicking the desired search
result and picking the Move Selected Images to
this Position item from the context menu. Once
you have assigned the geographical
coordinates, press the Apply button to write
geotags to the selected image (s).

Searching and Filtering

digiKam is designed to manage hundreds or
even thousands of photos, and includes
powerful search and filter capabilities. Simply
enter a search term in the search field of the
Text Filter section and digiKam automatically
finds photos with filenames, comments or tags
that match your specified criteria. The list of
available tags in the Tag Filter section can be

used to locate photos containing specific tags
– simply select one or more tags to display all
matching photos in the current album. The
Labels Filter section lets you filter photos
according to their color labels, picks and
ratings. Click on a particular label or status, and
you should see all matching photos. To use the
rating filter, select the desired number of stars
with the mouse. The software then narrows
the view to include only matching photos.

In addition to the search and filtering tools
in the Filters sidebar, digiKam offers advanced
search features, including the Calendar,
Timeline, Search, and Map Search options.
These are accessible via the left-hand sidebar. 

The Calendar section lets you quickly find
photos for a specific year, month and date.
Use the folder tree in the sidebar pane to
locate the year and month you are looking for.
If you want to view photos taken on a specific
date, use the calendar at the bottom of the
pane. Dates containing photos are marked in
bold type. The Timeline section offers a
different way to locate and view photos
covering a specific period of time. Here, your
photos are presented as a bar chart, and you

132 c’t Digital Photography 6 (2012)

digiKam | Search and Filter 

digiKam’s filtering capabilities help you to quickly find and view images that match specified criteria. The Filters sidebar has options for
filtering photos by type, tags, color labels and ratings. You can set up advanced filters by combining multiple criteria.



can view photos for a specific period by
clicking on the appropriate bar.

The Search section is designed for
performing searches in a more traditional
way. Type a search term in the Search field
and digiKam automatically displays matching
photos in the main pane. To make your search
more precise, press the Advanced Search
button. This opens the Advanced Search
dialog window, where you can specify
additional search options.

As you might have guessed, the Map
Searches section lets you locate photos taken
at a specific location. The map itself displays
thumbnails representing groups of
geotagged photos. Each thumbnail contains
a counter indicating the number of photos
found in the specific area. To view these, press
the Region Selection button (the middle
button in the Search by area section) to create
a region selection from a thumbnail. Using the
Area Selection button in the Search by area
section, you can view all photos in a manually
selected area on the map. To do this, press the
button, click anywhere on the map and drag a
rectangle around the desired area.

Working with RAW Files

The ability to process RAW files makes
digiKam a viable alternative to existing photo
management applications for hobby and
advanced photographers. By default, digiKam
automatically processes RAW files when you
open them for editing. If you prefer to tweak
your RAW files manually, you can enable the
RAW Import Tool. To do this navigate to the
Image Editor section in the Configure dialog
and enable the Use RAW Import Tool to handle
RAW images option. The next time you open a
RAW file for editing, digiKam will
automatically open the RAW Import interface
where you can adjust your RAW import and
post-processing settings.

The RAW Import sidebar is split into RAW
Decoding, Post Processing and Info tabs. In
the RAW Decoding section, you can adjust
demosaicing, white balance, noise reduction,
chromatic aberration correction and color
management settings.

digiKam supports several demosaicing
algorithms (Bilinear, VNG, AHD, LMMSE and
others), and the Shift+F1 keyboard shortcut

shows a brief description of each algorithm.
Since the RAW Import interface allows you to
preview tweaked images before you commit
your adjustments, you can try different
algorithms to see which one works best for
the current file. Select the algorithm you want,
and press the Update button to preview the
result.

The RAW Decoding section lets you tweak
other settings, too. Here, you can choose the
16-bit color depth option, which provides
better tonal range than the (faster) default 8-
bit mode. If you choose to work in 16-bit
mode, enable and configure the Color
Management options to prevent your images
from being rendered too darkly by the image
editor. You can adjust white balance settings
and specify how the system should handle
highlight clipping (i.e., overexposed image
areas) in the White Balance section (again, the
Shift+F1 keyboard shortcut displays
descriptions of the supported methods). In
addition, you can also enable and adjust the
Exposure Correction option and manually
tweak exposure compensation settings. The
Corrections section includes a selection of
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The Map Searches sidebar uses a map to find and display photos taken at a specific location. The current search can be saved for later use.



noise reduction algorithms and a chromatic
aberration correction option.

Finally, the Post Processing section
includes settings for adjusting brightness,
contrast, gamma, exposure and the
luminosity curve. Although you can make
these types of changes later when editing the
converted image, you can also set the
program to streamline the editing process by
performing them automatically during RAW
import.

You can use the RAW Import Tool to
process individual RAW files, but what if you

need to simultaneously convert multiple files?
This is where the Batch RAW Converter comes
into play. As the name suggests, the tool
allows you to process several RAW files at
once. Simply select the RAW files you want to
process and choose Tools > Batch RAW
Converter, configure the available options to
your liking and press the Convert button.

Editing Images

digiKam includes a wide range of editing
tools. Obviously, it would be impossible to

cover them all in one article, so let’s take a
look at a couple of the most interesting
ones. Like any quality photo editing
application, digiKam features curve and
level adjustment tools. The latter can be
used to adjust brightness and contrast by
specifying the location of pure black, pure
white and midtones in the image histogram.
This makes it a handy tool for tweaking
under- and overexposed image areas, as
well as improving overall tonal range. The
Color > Levels Adjust command in the Edit
interface opens the Adjust Levels tool. Select

The tools provided in the RAW
Import interface can be used to
make manual adjustments to
RAW files. You can choose
between different demosaicing
algorithms, adjust white
balance, enable noise reduction
and much more besides.

The Adjust Levels tool can be used
to adjust brightness and contrast
manually using its built-in sliders or
automatically using the Auto Adjust
button located to the left of the
Reset button
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Luminosity from the Channel drop-down
list, and press the Linear button. The
histogram in the tool’s sidebar contains two
sliders for adjusting shadows and highlights.
For example, if you want to darken shadow
areas in a photo, move the black point slider
to the right. Conversely, moving the white
point slider to the left boosts the highlights.
Another way to tweak levels is to use the
three color pickers next to the Automatic
level adjustment button. To fix shadows,
press the shadow tone color picker button
and click on an area in the image that

represents black. You can then adjust
midtones and highlights in a similar manner
using the appropriate color pickers.
Adjusting levels in the Red, Green, and Blue
channels help to boost colors and fix color
casts. 

Instead of using the Levels tool, you can
also use the Enhance > Local Contrast feature
to improve the dynamic range of an image by
reducing global and increasing local contrast.
You can apply up to four tone mapping
operations (called “Stages“) and you can
adjust the Power and Blur parameters for

each. Power controls the desaturation level,
while Blur enables you to directly adjust
affected image areas.

The Tools > Blend bracketed images tool
merges multiple shots with different
exposures into a single well-exposed image.
The feature is fairly basic, but is straightforward
to use and produces impressive results. The
Exposure Blending Import wizard will guide
you through the entire process, which consists
of adding source images, aligning them and
then blending them into one. The alignment
feature is really useful if you shot your source
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The Batch Queue Manager helps you to simultaneously apply several actions to multiple
photos. Among many other features, the tool can be used to watermark entire batches
of photos with a minimum of fuss.



images handheld. Once digiKam has finished
the blending process, you can tweak the
results manually using the Exposure Blending
editor.

You can either use the editing tools to
tweak individual images or the Batch Queue
Manager tool for simultaneously editing
multiple images. The tool enables you to set
up advanced processing profiles and manage
multiple queues. To add photos to the Batch
Queue Manager, select them in the main
program window and choose Image > Add to
Current Queue. To specify the actions you
want to perform on your queued images,
select the desired tools from the Base Tools
section and specify the settings for each in the
Tool Settings pane. The File Renaming section
in the Queue Settings pane lets you specify
renaming rules to prevent batch jobs from
overwriting your original files.

digiKam supports non-destructive editing
and versioning, which is useful not only for
modifying photos without affecting your
original image data, but also for saving
multiple versions of a photo and keeping track
of the changes you make. To enable this
feature switch to the Image Editor section in
the Configure dialog, tick the Enable Non-
destructive editing and versioning check box,

and configure the settings as you wish. Using
the versioning feature is simple – all you have
to do is press the Save As New Version button
in the editor. To view all versions of a specific
photo, select the original in its album and
expand the Versioning sidebar on the right.
You should then see all versions of the
selected photo with a complete list of the
editing actions you applied to them.

Sharing Photos

digiKam is designed not only for organizing
and editing photos, but also for sharing and
publishing. The application supports a wide
range of sharing options, from creating static
HTML photo galleries and generating KML
files for viewing your photos with Google
Earth, to uploading photos to popular photo
sharing services such as Flickr, Picasaweb,
SmugMug and many others. In addition 
to photo sharing web services, digiKam
supports popular self-hosted photo sharing
applications such as Gallery and Piwigo.

The program’s sharing capabilities are
simple to use. For example, if you want to
upload selected photos to your Flickr account,
choose Export > Export to Flickr. Authenticate
your account when prompted by the website

(which will identify the dialog as
FlickrUploadr) and enable the Flickr export
feature. In the Flickr Export window, select the
photos you want to upload and specify the
desired visibility settings (i.e., Public, Family or
Friends). The Upload Options tab includes
settings such as the target photoset, custom
tags, and image resizing and quality options.
Once you’re done, hit the Start Uploading
button and wait while digiKam takes care of
everything else. The other sharing options are
just as simple to use, making it easy to share
your photos without the digiKam interface.

Conclusions

digiKam offers all the tools you need to set up
a complete digital photo workflow, from
 importing and organizing to editing and
sharing. Even if you have already built a
workflow using a commercial application like
Adobe Lightroom, there are still situations in
which digiKam can be a useful addition to
your toolset. For example, if you install it on
your notebook to enable you to quickly
organize and process photos that you have
taken while you are out and about. However
you decide to use it, digiKam is free, so there
is no harm in giving it a try. (jr)  c
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Thanks to the Kipi plugins, you can upload photos directly to many popular photo sharing services directly from
within the application 

digiKam | Sharing
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Coming up in Issue 7 ... 

Extreme Detail 
with Gigapixel Images 

An entry-level DSLR is perfectly sufficient for
shooting the countless source images that
make up gigantic “gigapixel” images with
virtually unlimited resolution. Viewers can
zoom right into every detail of an online
gigapixel image and even the smallest
sections can be printed clearly and sharply.
This comprehensive article shows you 
how to produce gigapixel images using
conventional photo gear and specialized
software, and tests the limits of human and
machine in the process. The rewards for all
this effort are spectacular images that
provide a unique view of the world.

Lightroom Workflow Secrets 

Photoshop Lightroom is the perfect digital
photo workflow tool. Its five basic modules,
from Library through Develop to Print and
Web output, make it simple to control the
overall image creation process. In addition to
the basic workflow, Lightroom also offers a
wide range of specialized tools and functions
for simplifying and enhancing the cataloging
and image development processes. In this
article, Lightroom expert Maike Jarsetz 
uses a travelog to take us through the 
entire workflow, using practical, real-world
examples to demonstrate many of the
software’s standard and less well-known
features.

Dances with Light 

Painting with LEDs using custom light suits
during extremely long exposures has turned
into an art form of its own. Light Art
Performance Photography (or LAPP for short)
is rapidly gaining a worldwide following.
JanLeonardo Woellert is one of the genre’s
originators and one of its most prolific and
prominent practitioners. This article provides
a look behind the scenes of this mysterious
and fascinating world and includes sample
images by the master as well as tips and tricks
for creating your own LAPP images.






